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FOREWORD

I am delighted to present to you this textbook, which is developed by the Ministry of General 
Education and Instruction based on the new South Sudan National Curriculum. The National 
Curriculum is a learner-centered curriculum that aims to meet the needs and aspirations 
of the new nation. In particular, it aims to develop (a) Good citizens; (b) successful lifelong 
learners; (c) creative, active and productive individuals; and (d) Environmentally responsible 
members of our society. This textbook, like many others, has been designed to contribute to 
achievement of these  noble aims. It has been revised thoroughly by our Subject Panels, is 
deemed to be fit for the purpose and has been recommended to me for approval. Therefore, 
I hereby grant my approval. This textbook shall be used to facilitate learning for learners in 
all schools of the Republic of South Sudan, except international schools, with effect from 4th 
February, 2019. 

I am deeply grateful to the  staff of the Ministry of General Education and Instruction, 
especially Mr Michael Lopuke Lotyam Longolio, the Undersecretary of the Ministry, the staff 
of the Curriculum Development Centre, under the supervision of Mr Omot Okony Olok, the 
Director General for Quality Assurance and Standards, the Subject Panelists, the Curriculum 
Foundation (UK), under the able leadership of Dr Brian Male, for providing professional 
guidance throughout the process of the development of National Curriculum and school 
textbooks for the Republic of South Sudan since 2013. I wish to thank UNICEF South Sudan 
for managing the project funded by the Global Partnership in Education so well and funding 
the development of the National Curriculum and the new textbooks. I am equally grateful 
for the support provided by Mr Tony Calderbank, the former Country Director of the British 
Council, South Sudan; Sir Richard Arden, Senior Education Advisor of DfID, South Sudan. I 
thank Longhorn and Mountain Top publishers in Kenya for working closely with the Ministry, 
the Subject Panels, UNICEF and the Curriculum Foundation UK to write the new textbooks. 
Finally, I thank the former Ministers of Education, Hon. Joseph Ukel Abango and Hon. Dr John 
Gai Nyuot Yoh, for supporting me, in my previous role as the Undersecretary of the Ministry, 
to lead the Technical Committee to develop and complete the consultations on the new 
National Curriculum Framework by 29 November 2013.

The Ministry of General Education and Instruction, Republic of South Sudan, is most grateful 
to all these key stakeholders for their overwhelming support to the design and development 
of this historic South Sudan National Curriculum. This historic reform in South Sudan’s 
education system is intended to benefit the people of South Sudan, especially the children and 
youth and the future generations. It shall enhance the quality of education in the country to 
promote peace, justice, liberty and prosperity for all. I urge all Teachers to put this textbook 
to good use. 

May God bless South Sudan. May He help our Teachers to  inspire, educate and transform the 
lives of all  the children and youth of South Sudan.

 

Deng Deng Hoc Yai, (Hon.)

Minister of General Education and Instruction, Republic of South Sudan
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Unit 1 Computer Networks

Learning Outcomes
The learners should share what they already know about 
computer networking, intranet and internet, file sharing 
and network application software such as MS Outlook.

In small groups and individually they should 
develop an understanding that a network is a set 
of computers connected together to share data, 
facilities and other resources.

They should learn individually and in small groups how 
to manage contacts, set up common events in the calendar 
(meeting schedules), create task lists and share common 
folders and files in an intranet environment (e.g. Microsoft 
Outlook).

As a class they should understand the opportunities 
that computer networks offer in communications and 
collaboration, and the risks associated with it. They 
should understand and contrast internet and intranet, 
describe how file sharing works in an intranet set up, 
and explain how network application works.

Key inquiry questions

• Why are computer networks important now and in 
the future?

• Why do organizations and institutions develop and 
depend upon intranet?
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1.0 Introduction to computer networks
A computer network is a collection of  computers and other hardware 
components interconnected by communication channel that allow sharing of  
resources and information.

Computers on a network are called nodes. This is a device capable of  sending or 
receiving data generated by other nodes on a network. Addresses on the other 
hand are numeric quantities that are easy for computers to work with. Each node 
has a unique address.

Figure 1.  A computer network illustration.

Connection between computers can be done through cables, commonly 
the Ethernet cable or through radio waves. Networks are used to perform 
various functions. These functions include:

• Making information readily available among users in a network.

• Helping in sharing of  files or documents across the network.
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• A network enables the sharing of  computer hardware e.g.  Printers among 
the multiple users in a network.

• Makes it possible to share software on remote systems.

• Allows for communication via video, email, among many others.

A computer network is also called a data network. The most common form of  
a network is the internet. A network must be able to meet certain standards as 
outlined below:

1.   Performance - this the speed at which a computer network operates.

Computer performance can be measured in two major ways:

• Transit time - This is the time taken to travel a message from one device 
to another. The shorter the transit time the better the performance of  the 
computer network.

• Response time -It is the time taken between enquiry and response. The 
faster a replay is gotten after it has been requested through a network then 
the more efficient a network is.

2.   Security: This refers to the protection of  data from access by unauthorized or 
unintended users. In a network data passes through many layers and can hence 
be tracked, therefore security in any computer network is paramount.

3.   Reliability: It is the ability to depend upon the computer network. This means 
that the frequency at which a computer network fails should be low making the
network reliable.

History of earlier computer networks

• The earliest examples of  computer network was a network of  
communicating computers that functioned as part of  the U.S military’s 
semi-Automatic Ground Environment (SAGE) radar system.

• In 1969, the University of  California at Los Angeles, the Stanford Research
Institute, the University of  California at Santa Barbara and the University 
of  Utah were connected as part of  the Advanced Research Projects Agency 
Network (ARPANET) project. It is this network that evolved to become 
what we now call the internet.

• In the 1980s access to the ARPANET was expanded. The internet protocol

was suite (TCP/IP) was introduced as the standard networking protocol on
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the ARPANET. Commercial internet service providers (ISPs) began 
to emerge in the late 1980s.

• In March 2000, Tele west launched home ADSL-asymmetric digital
subscriber line. In 2002 there were fewer than 200,000 broad band users 
this grew to over 13 million some few years later.

• In 2005 an online file sharing and personal cloud content management 
service for business was launched.in 2011 fiber-optic broadband make 
broadband speeds reach 100mbps.This leads to end users needing better 
routers to match the broad speed. In 2014 the new WI-FI standards 802.11ac 
launches, offering faster speed of  over 2 Gbps compared to 450mbps of  
the previous 802.1n standard.

Currently, the market has evolved and the demand for wireless continues t o grow 
as smart home tech becomes more mainstream.

Activity 1.1

As computers networks evolved, the computers have at the same time become 
more complex. Find out what the technological changes were, that allowed for 
different computer generations. Work with your teacher.

In groups discuss and find out how these eras impacted on computer networks:

1st generation - vacuum tubes (1940-1956)

2nd generation – transistors (1956-1963)

3rd generation – integrated circuits (1964 -1971)

4th generation – microprocessor (1972-2010)

5th generation – artificial intelligence (2010 onwards)
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Benefits of computer networks

Networks make computers and their users capable of  being connected together. 
Among the benefits of  computer networking include:

• Resource sharing-Networks are capable of  sharing one resource, such as 
a printer, for several computers. This allows many separate computers to 
access a single network resource. In the long run this saves money and space 
for the organization.

• Data sharing - Computer networks makes it easy to share documents. The 
type of  server that stores files is called a file server. Data can be in the form 
of  text, images, numbers or characters.

• Cost efficiency - Computer networking helps one to use software products 
available in the market by installing them in the server and sharing them 
among various workstations hence saving cost.

• Flexibility - Computer networking is known to be flexible as it gives 
u sers the chance to explore vital things like software without affecting 
their functionality. It also allows people to have the accessibility to all 
information they need to get and also share.

• Management of  data - Computer networking helps in centralization of  
data from all the user systems to one system where it can be managed in an 
easier and better way.

Activity 1.2
Discuss the challenges that small companies are likely to face while using computer
networks in South Sudan. Give suggestions on how you can solve these challenges.

Connecting devices in computer Networks
As stated when introducing the topic, a network is a connection made through 
joining links among two or more devices .These devices may range from a 
computer to a printer or any other device that is capable of  sending or receiving 
data. There are two ways of  connecting these devices in a network.
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1) Point-to-point connection. (PPP)

It is a communication which is used as a communication link between two devices. 
PPP connects two routers directly without any host in between. An example of  ppp 
connection is a computer connected to a printer or connection between remote 
control and television for changing the channels.

Figure 1.  Point to point connection

2) Multipoint connection.

Multipoint connection is a connection where two or more devices share a single 
link. In this connection all data sent by one user is received by all the other users. 
Multipoint connection is also referred to as multi-drop configuration.

Figure 1.3 Multipoint configuration.
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1.2 Types of  computer networks

Networks are communication systems designed to convey information from the 
origin to a particular destination. Networks can be understood in two ways:

• Local -as in local area network, which covers a small area and have a 
relatively small number of  users.

• Global- which cover long distance and have an unlimited number of  users.

A computer network is interconnection of  various computer systems located at 
different places. Two or more computers are linked together for the purpose of  
sharing resources and information.

Figure 1.4 Computer Networks.

1.2.1 Personal Area Network (PAN)

It is the smallest and the most common type of  network. It consist of  a wireless 
modem, a computer or two phones, a printer and it revolves around one person. 
PAN are mostly found in small offices or residences and they are mostly managed 
by one person from a single device.

Activity 1.3
Create a personal area network in your class.
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1.2.2 Local Area Network (LAN)

A local area network (LAN) connects a group of  computers in close proximity 
to each other such as in an office building, a school, or a home to enable sharing 
of  resources and information. LAN covers a small geographical area. The various 
devices in LAN are connected to the central devices. Most local area networks are 
built with hardware such as Ethernet cables, network adapters, and hubs. LAN may 
also be installed using wireless technologies.

Among the major difference between LAN and WAN is that LAN has a higher rate 
of  data transfer and also it is limited in its geographical range.

Figure 1.5.Different topologies interconnected in a LAN

Every network, system or device has its advantages and disadvantages. LAN is no 
exceptional. It benefits include:

• Easy and cheap communication as data can be transferred easily 
over networked computers.

• Helps in centralization of  data since all the data in the network can be saved 
on the hard disk of  the server computer.
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• Helps in resource sharing where by computer resources like printers, 
modems and hard disks can be shared using LAN.

• Ensures security of  data since it is stored on server computer which central 
this also helps in managing the data.

• Aids in sharing of  applications software this proves cheaper instead of  
purchasing separate licensed software for each user in a network.

• LAN provides the facility to share a single internet connection among all 
the LAN users. Internet sharing helps save cost on internet expenses.

The major disadvantages of  LAN are:

• The initial set up cost of  installing LAN is high.

• The data may be accessed by unauthorized personnel especially if  the 
centralized data is not managed properly.

• LAN is limited in terms of  the geographical area that it can cover. It covers 
a small area like a building or office.

• It requires a lot of  maintenance job since there are a lot of  software or 
hardware failures.

• It has no privacy since the LAN administrator may check the personal data 
files for each and every LAN user.

1.2.3 Wide Area Network. (WAN)

It usually refers to a network which covers a large geographical area, such as a state 
or a country. It operates on low data rates. A WAN can contain multiple smaller 
networks, such as LANs or MANs. The Internet is the best-known example of  a 
public WAN.

Activity 1.4

In pairs, compare and contrast between local area networks LAN and wide area 
networks WAN.
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WAN provides lots of  benefits that help users to communicate with the world 
around them. These benefits include:

• Data can be shared on the Network. This ensures that no users get 
information before than others.

• Ensures messages are sent quickly to everyone on the network.

• It covers a large geographical area.

• It helps in sharing software and resources with those on the network.

• Expensive hardware like printers can be shared without having to buy for 
each computer.

Like any other network, WAN has some setbacks or disadvantages. Among these 
drawbacks are:

• Requires a lot of  security to ensure that outsiders do not enter and disrupt 
the network.

• The initial cost of  setting up a WAN is very high. The larger the network is 
the more expensive it is to set up.

• It also requires full time supervisors and technicians to maintain it once it 
has been set.

• It is more prone to hackers and viruses since it is available to many people.

Kampala

Juba

Nairobi
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Activity 1.5

In groups, find out why WAN is not suitable for use in the rural areas of  South

Sudan, and propose an appropriate alternative. Prepare to defend your suggestion 
to the class based on what you know about various types of  computer networks.

1.2.3 Metropolitan Area Network (MAN)

A MAN is a relatively new class of  network. It consists of  a computer network 
across an entire city, college campus or small region. Hence a MAN is basically 
bigger than a LAN even in terms of  the geographical area tough it rarely extends 
beyond 100 km. It can also be a means of  connecting a number of  LANs to form 
a larger network.

Figure 1.6 Metropolitan area networkin.g

This type of  networking has many benefits. Among the advantages of  Metropolitan

Area Network include:

• It is efficient and provides fast communication.

• It can be used when transmitting information in both direction 
simultaneously.

• It covers a relatively larger area e.g. a city.

• It can be used to interconnect a number of  local area networks.

Requiring a lot of  cables and being difficult to secure the network from hackers are 
among some of  the disadvantages of  Metropolitan area network.
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A wireless network is a computer network that uses wireless data connections 
between nodes. The wireless networks are becoming more important because the 
wired connection are limited. For instance they cannot be installed in cars or aero 
planes. Wireless networks can have many application s. A very common example 
is the portable office.

Wireless networks can be divided into three main categories. These include:

1. System interconnection:

This involves interconnecting various components of  the computer using short 
range radio. The most common is the use of  Bluetooth. This helps connect various 
components such as the monitor, keyboard, printer, and also mouse without 
necessarily using wires. It is also able to connect cameras, scanners, headsets among 
many other devices to the computer by bringing them close to the computer.

2. Wireless LANs:

They provide wireless network communication over short distances using radio or 
infrared signals instead of  traditional network cabling. In this case each computer 
has a radio modem and antenna with which it can communicate with other systems.

3. Wireless WANs:

Wireless WAN is a wide area network in which separate areas of  coverage or cells 
are connected wirelessly to provide service to a large geographic area. An example 
of  this kind of  network is the radio network which is used for cellular phones.

xFigure 1.7 Wireless WAN.
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Exercise 1

1.   State, with reasons, two items of  hardware that could be needed for a personal 
computer to connect to the Internet.

2.   A company is having a sixteen-station Local Area Network (LAN) installed. 
a)   Describe what is meant by the term Local Area Network.

b)  Give two suitable topologies for the LAN and, for each one, draw a labelled

diagram to show its structure.

c)   State three items of  hardware and/or software that could be needed if  the

LAN is to be connected to the Internet.
3.   There are ten employees in a local estate agent’s office. Each employee uses 

a networked PC on a Local Area Network (LAN).

a)   Give four benefits to the office of  using a network rather   than stand-alone

PCs.

b)  The office is part of  a national chain that is connected together over a Wide

Area Network (WAN).Explain the difference between a LAN and a WAN.

1.3 Networks topology

A Network Topology is the arrangement with which network devices are connected 
to each other. Topologies may define both physical and logical aspect of  the network. 
Topologies can also be defined as the explanation of  a network organization, linking 
various nodes through lines of  connection. Network
topologies are in many types. These may include:

1.3.1 BUS Topology

It is a network in which every computer is connected to a single cable or a common 
medium. It has two end points. Each communication device on the network 
transmits electronic messages to other devices. If  these messages collide, the

sending device waits and then tries to transmit again.
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Figure 1.8 Bus topology

Bus topology has many benefits. Among these advantages are:

• It is cost effective.

• Suitable for use in small networks.

• It normally easy to expand by joining cables together.

• It requires a smaller cable as compared to other network topology.

Bus topology like any other network topology also has its challenges. These include:

• It is slower in comparison to ring topology.

• If  the cable fails then the whole network fails.

• Its performance efficiency decreases with increase in nodes.

1.3.2 RING Topology

In this case, each computer is linked to another computer, the last computer is then 
connected to the first one to form a continuous loop. Signals are hence sent around 
until they reach the accurate destination since there is no central server.
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Figure 1.9 Ring topology.

Features of  Ring Topology include:

• Data is transferred in a sequence manner.

• Transmission is one way but can be made to two way by having 2 
connections between each node. This is called dual ring topology.

• In dual ring topology, there is two ring network where data flows in 
opposite direction.in case of  one ring breaking down the second rings acts 
as back up and keeps the network running.

• Ring topology has a number of  repeaters with large number of  nodes. 
This helps prevent data loss as data moves through the nodes.

The advantages of  using ring topology include

• It is cheap to install.

• It is not affected by high traffic.

• Good for handling high capacity traffic since every computer acts as 
a booster of  the signal.

Adding computers in ring topology is cumbersome since failure in one computer 
affects the whole network. Troubleshooting in topology set up is also difficult to
carry out.
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1.3.3 Star topology

All computers are connected to a central device using the point to point 
connection. The central device is called the hub, switch or router.

Figure 1.10 Star topology.

In the star topology, the hub, switch or router acts as the repeater for data flow. 
Computers in star topology are connected independently to the central hub. These 
Computers are connected using optical fiber, twisted pair or coaxial cable. Among 
the advantages of  star topology are:

• Startup costs are low.

• Easy to add new nodes to the network.

• Upgrading the hub is easy.

• Fast performance with few nodes and low network traffic.

• If  one connection between a computer and the hub fails, the connections 
are not affected.
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In star topology if  the central hub fails, the entire network goes down since they 
are inter connected. Star topology also requires more cables in comparison to other 
topologies like the bus topology hence becoming more expensive.

1.3.4 MESH Topology

It is a point to point connection to other nodes. In this setup every node 
participating in the network is connected to every other node.

There are two major types of  Mesh Topology:

1.   Partial mesh-This is where some systems are connected as in the case of  
mesh topology but some devices are only connected to two or three devices.

2.   Full Mesh Topology -In this set up each node is connected to each other.

Figure 1.11 Mesh topology.

In the mesh topology set up data takes the shortest path to reach its destination. 
Mesh topology presents many benefits these may include:

• It is robust hence if  one connection fails, the others remain intact.

• Security and privacy is high since data travels through a dedicated 
connection.
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• Can handle very high volume traffic due to presence of  dedicated links.

• Fault identification is easy.

As in the case with any topology, mesh topology has shortcomings. Among the 
shortcomings are:

• Requires a lot of  cables hence making it expensive.

• Most of  the connections become redundant since there are several different 
paths for data to travel from one node to another.

• Installation and configuration is difficult.

Activity 1.6

In groups, what conclusions can you draw on tree topology and hybrid topology?
Can you make a distinction between the two?

Exercise 2

1.   Physical or logical arrangement of  network is called?

2.   In which type of  topology is there a central controller or hub?

3.   Which type of  topology requires multipoint connection?

4.   List 6 different network topologies?

5.   List the advantage and disadvantage of  Bus topology?

6.   List the advantage and disadvantage of  Star topology?

7.   List the advantage and disadvantage of  Ring topology?

8.   What are the advantage and disadvantage of  mesh topology?
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1.4 Data transmission Modes in Computer 
Networks

Data transmission mode defines the direction of  the flow of  information between 
two communication devices. It is also called communication mode. Networks are 
designed to allow communication to occur between individual devices that are 
interconnected.

Data transmission modes can be in three forms namely:

• Simplex Mode.

• Half-Duplex Mode.(HDX)

• Full-Duplex Mode.(FDX)

Figure 1.12 Data transmission modes.

The data is sent only in one direction. Only one of  the two devices on a link can 
transmit, the other can only receive. This means that there is no mechanism for 
information to be transmitted back to the sender. The simplex mode uses the entire 
capacity of  the channel to send data in one direction. An example of  a simple mode 
is a Communication between a computer and a keyboard.
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Figure 1.13  Simplex mode.

1.4.1 Half-Duplex Mode (HDX)

Half-duplex data transmission means that each station can transmit data in both 
directions, but not at the same time. That means that when one is sending the other 
device is receiving and vice versa. The half-duplex mode is suitable in cases where 
there is no need for communication in both direction at the same time. For example 
a walkie-talkie.

Figure 1.14  Half  Duplex mode.
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A full duplex system can send data at the same time in both directions on the 
transmission path. This means that it is bidirectional. This mode ensures that the 
entire capacity of  the channel is utilized for each direction. It is more effective 
where communication is required in both directions and at the same time.

Figure 1.15  Full duplex mode.

1.5 Intranet

An intranet is a network that is restricted to one organization. Intranet consists 
of  many interlinked local area networks and also use leased lines in the wide area 
network. An intranet can also be understood to be an internal or restricted access 
network. It is very similar to the Internet except it is used within organizations and 
businesses. The intranet uses the same types of  web technologies that the normal 
Internet or extranet uses, only that the content and data that is transmitted and 
received occurs internally.

1.5.1 Comparison between internet and intranet

Internet Intranet

Internet is wide network of  computers
and is open for all

Intranet is also a network of  computers
designed for a specific group of  users.

Internet itself  contains a large number
of  intranets.

Intranet can be accessed from Internet
but with restrictions

The number of  users who use internet
is Unlimited.

The number of  users is limited.

The Visitors traffic is unlimited. The traffic allowed is also limited.
Internet contains different source of
information and is available for all.

Intranet contains only specific group
information
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Therefore the Internet is an open, public space, while an intranet is designed to be a 
private space. An intranet may be accessible from the Internet, but it is protected by
a password and accessible only to authorized users.

Intranet and internet also have similarities.

• Both Internet and Intranet can be accessed using any browser.

• They use Internet Protocols for transferring data.

• Both of  them are used to share information with the users over 
the network.

Hence, in conclusion both Internet and Intranet have some similarities and 
differences as well. The Internet is a collection of  various LAN, MAN, and WAN 
whereas, Intranet mostly is a LAN, MAN or WAN.

Activity 1.7
In groups, discuss how various international organizations working South Sudan 
could develop and depend upon intranet.

1.5.2 File sharing in an intranet set up

The main purpose of  an intranet is to share company information and computing 
resources among employees. An intranet can also be used to facilitate working in 
groups and for teleconferences

When using windows the following process is followed when one wants to share 
files:

1.   Locate the folder you want to share and right click on it.

2.   Choose “Share with” and then select “Specific People”.
3.   A sharing panel will appear with the option to share with any users on the 

computer or your home group. You can also choose to share with “Everyone”, 
which means the files will be accessible on your local network. If  you want to 
choose this option, you can find it by clicking on the drop down menu towards 
the top of  the panel.

4.   After making your selection, click Share.
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After you have clicked Share, Windows will take a moment to set up your new 
shared folder and it will be accessible from other computers on your local network. 
To access it, simply look for your computer’s name in the Network section on your 
other computer. When you choose it, you will have a new option to connect to this 
folder.

How file sharing works in a network.

Sharing of  files in network can be done in two ways:

1.   Peer to peer file sharing.          2.   File synchronization

Peer to peer file sharing. (P2P)
P2P file sharing is the process of  sharing and transferring digital files from one 
computer to another using P2P software. In a P2P network, each ‘peer’ is an 
end- user’s computer connected to the other ‘peer’ via the Internet, without going 
through an intermediary server. P2P programs can be an efficient way to share 
large files with others, such as personal video recordings or large sets of  photos. 
P2P is also used to facilitate direct communications between computer or device 
users.
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Risks of Using P2P File Sharing
There are various risk associated with sharing files using p2p. These risks introduce 
security risks that may put your information or your computer in danger. These 
risks include:

• Exposure of  sensitive or personal information -Vast amounts of  personal 
information may be shared and stolen through P2P networks. These may 
include names, birthdates and Social Security numbers. Once information has 
been exposed to unauthorized people, it is difficult to know how many people 
have accessed it.

• Prosecution - Files shared. through P2P applications may include pirated 
software, copyrighted material, or pornography.

• Denial of  service - Downloading files causes a significant amount of  traffic 
over the network. This activity may reduce the availability of  certain programs 
on your computer or may limit your access to the internet.

• Susceptibility to attack -The probability of  exposure to Trojans and viruses 
found in shared files is high. They attack your computer by taking advantage of  
any vulnerabilities that may exist in the P2P application.

Reducing the risks when using P2P file sharing.

Only use legal file-sharing services. In order to avoid legal issues like 
sharing copyrighted materials like music always use legal downloading 
sites.

Be alert when installing file-sharing software. When installing a file 
sharing software ,it good to be cautious to ensure  that you are not 
accidentally sharing your private content with the outside world.

Make sure you have up-to-date security software on your computer.

Close the P2P connection when you’re finished. When you close a file- 
sharing software program’s window, your connection to the P2P network 
may remain active. This could give others access to your shared files, 
which in turn may increase your security risks.

Using file synchronization.
Syncing is the process of  ensuring that computer files in two or more locations 
are updated via certain rules. It may be understood in two ways. The first way is 
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one- way file synchronization where the updated files are copied from a particular 
location to one or more target locations, but no files are copied back to the source 
location and second is the two-way file sync, where updated files are copied in 
both directions, usually with the purpose of  keeping the two locations identical to 
each other. It is commonly used for home backups on external hard drives.

1.5.3 Using network application in resource sharing

Shared resources, also known as network resources, refer to computer data, 
information, or hardware devices that can be easily accessed from a remote 
computer through a local area network (LAN) or intranet. Successful shared 
resource access allows users to operate as if  the shared resource were on their 
own
computer. The most frequently used shared network environment object s are files,

data, multimedia and hardware resources like printers, fax machines and scanners.

Activity 1.8
In pairs, find out how network application can be used to ease resource 
sharing within and among various organizations in South Sudan.

1.6 Microsoft outlook
Microsoft outlook is a personal information manager provided for by Microsoft 
office. Microsoft outlook can be used by multiple users in an organization, to 
share mailboxes and calendars, exchange public folders, SharePoint lists, and 
meeting schedules.

     

Figure 1.18 Microsoft outlook icon.
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1.6.1 Opening Outlook

When using Microsoft windows, click the Start button, click All Programs, click
Microsoft Office, and then click Microsoft Outlook.

1.6.2 Creating and managing contacts

For Microsoft Outlook to be useful, it should have contacts. It is advisable to have 
contacts already in Outlook, so as to send messages faster.

In order to manage contacts in Microsoft outlook, one requires to create an address 
book. If  you don’t have an address book to import, you can start adding contacts 
manually.

The screenshot below shows a portion of  a new address book which is empty.

Figure 1.19  Address book

1.   To start, click the “New Contact” button which will open a new contact 
window. Like the one in the next page.
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2.   Fill in the contact form.

3.   After finishing entering the contact or contacts, you may either click “Save

& Close” or you can click “Save & New” to generate another contact.

How to edit a contact or contact list.

After saving a contact or a contact list one may require to make changes to the list. 
This can be done through editing the contact or the contact list. In order to edit a 
contact or a list a procedure has to be followed. The procedure involves:

1.   In Outlook, select the app launcher then the People tile.

2.   Select the contact or contact list that you want to edit, and select Edit.

3.   Make the changes that you want.
4.   Select Save.

1.6.3 Setting up common events in the calendar

In order to set up common events in the calendar, one must be able to access 
calendar in the Ms Outlook.
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Finding your Calendar: Outlook may open directly to your calendar, if  not, click 
on the calendar icon in the lower left hand of  the Navigation Pane.

Creating entries on your calendar:  Entries will appear on Outlook calendar 
as appointments, meetings or events.

1.6.3 Meetings

A meeting is an appointment that includes other people. It can also mean an 
assembly of  people for a particular purpose, especially for formal discussion. 
Replies of  meeting requests appear in in the Inbox. Outlook helps one find the 
earliest time when all the invitees, are free. When you send the meeting request 
by email, the invitees receive the request in their Inbox, where they can accept, 
tentatively accept, or decline your meeting by clicking a single button. If  your 
request conflicts with an item on the invitees’ Calendar, Outlook displays a 
notification. If  allowed by the meeting organizer, invitees can propose alternate 
meeting times. If  you are the meeting organizer, you can track who accepts or 
declines the request or who proposes another time for the meeting by opening 
the request.

1.6.4 How to schedule a meeting

1.   Click new meeting in the group on the home tab in the calendar.

2.   Type a description in the Subject box.

3.   Type a description or location in the Location box. The location field is 
a text field that is not attached to resources entities.
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4.   In the Start time and End time lists, click the start and end time for the 
meeting. If  you want to schedule meetings based on an alternate time 
zone, click Time Zones in the Options group on the Meeting tab.

5.   In the meeting request body, type the information that you want to 
share with the recipients. You can also attach files.

6.   Click Scheduling Assistant in the Show group on the Meeting tab. The 
Scheduling assistant helps you find the best time for your meeting.

7. Click Add Others, and then click add from Address Book.

8. Click on the Select Attendees and Resources dialog box, then in the Search 
box, enter the name of  a person, to include at the meeting.

9.   Click the name from the results list, click required or Optional and then 
click OK. Required and Optional attendees appear in the top box on 
the Meeting tab.

10. To set up a recurring meeting, on the Meeting tab, in the Options group, 
click Recurrence. Choose the options for the recurrence pattern you 
want, and then click OK.

11.  To change the advance time of  the meeting reminder, click reminder on 
the Meeting tab, in the Options group, and then click the time you want. 
Click none to turn off  the reminder.

Activity 1.9
In groups, schedule a meeting of  your school debate club using Microsoft outlook. 
Choose one member of  your group to make notes and one to lead the group. After 
the discussion prepare to feedback main steps you used to schedule the meeting 
and demonstrate through demonstration.

1.6.5 Events

An event is an activity that lasts 24 hours or longer. Some examples of  an event 
include a trade show, a vacation or a seminar. Usually, an event occurs once and can 
last for one day or several days. An annual event, such as a birthday or anniversary, 
occurs yearly on a specific date.
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How to create an event.

1.   On the Home tab of  the calendar, click on the new group, click new 
Items, and then click All Day Event.

2.   In the Subject box, type a description of  the event.

3.   In the Location box, enter the location.
4.   To indicate to people who are viewing your calendar that you are out of  

office instead of  free, on the Event tab, in the Options group, click Out 
of  Office

5.   If  the event lasts longer than one day, change the values in the Start time 
and End time boxes.

6.   Click Save and Close.

Activity 1.10
Create a meeting invitation, inviting your teacher to a half-hour meeting with you 
tomorrow at 2:00 PM in your classroom, to discuss what you have learned in 
class. Send the meeting invitation
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1.6.6 Creating a task list

MS Outlook helps one make to-do lists consisting of  tasks, which you can do all 
sorts of  things, such as setting due dates, reminders, categories, and more.

In order to create a task you must open Outlook up to the Tasks view. At the 
beginning the tasks view is empty if  there is no event like the one shown below.

To start, in Ms Outlook there is one task folder group call My Tasks and two sub 
task folders: To-Do List and Tasks. When you right-click on the top-most folder, 
you can create a “New Folder Group”.

You can add a quick task by clicking on “Click here to add a new Task” or you can 
click “New Task” on the Home ribbon.

You then fill out your task and include some basic details and then click “Save & 
Close.”
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After you have created a few tasks, you are able to see them listed in the Tasks view. 
MS Outlook allows one to do some modifications such as changing the due date or 
assigning a category. In order to view and edit you need to double-click to open it.

In order to make any changes, click on the “details” button.

Ms Outlook allows one to delete or forward a task if  you decide. It also allows one 
to manage the task, such as marking it complete, assigning it, and sending a status 
report.
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Key points

Practical exercise

Step 1: Quick overview of  Outlook Menus and Toolbars

Log in to your outlook account.

Step 2: Create a Signature

Under Options, find Messaging Options, and click on “Edit Signature”. Create 
a basic Signature containing your name and contact information. Click Save and 
Close, and then check the box next to “Automatically include…” and click Save 
and Close.

Step3: Read an email message

Double click on the mail message with the subject “Email etiquette” to read it.

Step 4: Reply to mail

Reply to my “Email etiquette” message. Reply to sender only.

Step 5: File mail message

While viewing the “Email etiquette” message, click on the Move/Copy icon (  ) 
and select “New” to create a new folder called “Outlook Exercise”. Move this 
message into this folder.

Step 6: Creating Rules

Create a new Rule named “Exercise” which will automatically file all messages from 
sender with the name “teacher” into your “Training” folder.

Step 7: Compose an email message and add an attachment

Send a message to you teacher email: with the file on your computer titled 
“discussion lists” included as an attachment. You may include any additional 
text, comments, etc. that you want.

Step 8: Creating a contact list
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Exercise 3

1.   Under what conditions can two devices be said to be in a network.

2.   What are computer network nodes?
3.   Which device forwards packets between networks by processing the routing 

information included in the packet?

4.   What is a Link in computer networks?

5.   What is point to point link?
6.   How does a network topology affect a company’s decision in setting up a 

network?

7.   What are the different ways of  securing a computer network?
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Remember
COMPUTER NETWORKS

Access - Referring to the ability of  a computing device to use data or resources 
beyond its native capabilities.

Access List - List kept by routers to control access to or from the router for a number 
of  services. For example, the list can prevent packets with a certain IP address from 
leaving a particular interface on the router.

Adapter - Hardware that allows a computing device physical access to a network.

Analog - Referring to a system or component that uses a system of  measurement, 
response or storage in which values are expressed as a magnitude using a continuous 
scale of  measurement.

Analog Transmission - Signal transmission over wires or through the air in which 
information is conveyed through variation of  some combination of  signal amplitude, 
frequency, and p hase.

API - Application Programming Interface. A set of  tools and procedures provided by 
the programmer of  an application so that other programmers can control, exchange 
data with, or extend the functionality of  an application.

Architecture - The sum total of  all of  the specifications, protocols and 
implementations that define a particular networking system.

ARCnet - Attached Resource Computer Network. A 2.5-Mbps token-bus LAN
developed in the late 1970s and early 1980s by Datapoint Corporation.

ARP - Address Resolution Protocol. The protocol for mapping IP addresses to 
physical addresses such as Ethernet or Token Ring.

ARPANET- Advanced Research Projects Agency Network. Landmark packet 
- switching network established in 1969. ARPANET was developed in the 1970s 
by BBN and funded by ARPA (and later DARPA). It eventually evolved into the 
Internet. The term ARPANET was officially retired in 1990.
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ASCII - Referring to a standard 7-bit character system that includes the alphanumeric 
characters and printer control codes.

Associative Memory- Memory that is accessed based on its contents, not on its 
memory address. Sometimes called content addressable memory (CAM).

Asymmetry - In networking, a system in which the relationship between two entities 
is inherently unequal, with each entity restricted to a set of  operations and prerogatives 
defined by its role in the relationship.

Back End - Node or software program that provides services to a front end. See also 
client, front end, and server.

Bandwidth - In analog communications,  the difference between the highest and lowest 
frequencies available in the band. In digital communications,  bandwidth is loosely used 
to refer to the information-carrying capacity of  a network or component of  a network.

Binary - 1. A numerical system using “2” as its base. 2. Data that is encoded or presented 
in machine-readable  form (1’s & 0’s).

BOOTP -Bootstrap Protocol. An IP protocol used by diskless workstations to receive 
boot information from a boot server.

Border Gateway - Router that communicates with routers in other autonomous systems.

Buffer - A temporary memory storage area for information.

Bus - A type of  network topology in which nodes are connected along a continuous path 
that is not a closed circuit. Also refers to a communications  channel used by a single 
computer such as Nubus, SCSI, etc.

Cable - The transmission media of  a network.

Cache - A group of  memory locations set aside for temporary storage of  data, especially 
frequently-used data or data needing high speed retrieval by the CPU.

Catenet - Network in which hosts are connected to diverse networks, which themselves 
are connected with routers. The Internet is a prominent example of  a catenet.

Cellular Radio - Technology that uses radio transmissions to access telephone- company 
networks. Service is provided in a particular area by a low-power transmitter.

Console - In SNMP (Simple Network Management Protocol), a software program that 
has the capability of  interacting with an agent, including examining or changing the values 
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of  the data objects in the agent’s Management Information Base (MIB).

Data Base - A collection of  data that can be selectively retrieved by a type of  application 
knows as a Data Base Management System.

Data Link - The physical connection between two devices such as Ethernet, Local 
Talk or Token Ring that is capable of  carrying information in the service or networking 
protocols such as AppleTalk, TCP/IP or XNS.

Data Link Protocol - The protocol that controls the network signaling and receiving 
hardware, performing data integrity checks and formatting information according to 
the rules of  the data link.

Domain - 1. In the Internet, a portion of  the spanning hierarchy tree that refers to 
general groupings of  networks based on organization type or geography. 2. In SNA, 
an SSCP and the resources it controls. 3. In IS-IS, a logical set of  networks.

Fiber optic - A transmission media that uses a light wave for signaling.

Fiber-optic Cable - Physical medium capable of  conducting modulated light 
transmission. Compared with other transmission media, fiber-optic cable is more 
expensive, but is not susceptible to electromagnetic interference and is capable of  
higher data rates. Sometimes called optical fiber.

Firewall - Router or access server, or several routers or access servers, designated as a 
buffer between any connected public networks and a private network. A firewall router 
uses access lists and other methods to ensure the security of  the private network.

Hybrid Network - Internetwork made up of  more than one type of  network 
technology, including LANs and WANs.

Interface - 1. Connection between two systems or devices. 2. in routing terminology, a 
network connection. 3. In telephony, a shared boundary defined by common physical 
interconnection characteristics, signal characteristics, and meanings of  interchanged 
signals. 4. The boundary between adjacent layers of  the OSI model.

IP - Internet Protocol. The Network Layer protocol in the TCP/IP stack offering 
a connectionless internetwork service. IP provides features for addressing, type-of- 
service specification, fragmentation and reassembly, and security.

IP Address - 32-bit address assigned to hosts using TCP/IP. An IP address belongs 
to one of  five classes (A, B, C, D, or E) and is written as 4 octets separated with 
periods (dotted decimal format). Each address consists of  a network number, an 
optional subnet work number, and a host number. The network and subnetwork 
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numbers together are used for routing, while the host number is used to address an 
individual host within the network or subnetwork. A subnet mask is used to extract 
network and subnetwork information from the IP address. Also called an Internet 
address. See also IP and subnet mask.

LAN - A communication infrastructure that supports data and resource sharing 
within a small area (<2 km diameter) that is completely contained on the premises of  
a single owner.

Loop - Route where packets never reach their destination, but simply cycle repeatedly 
through a constant series of  network nodes.

Mesh - Network topology in which devices are organized in a manageable, segmented 
manner with many, often redundant, interconnections strategically placed between 
network nodes.

Modem - A device that can covert data signals between analog and digital signaling 
systems.

NAP - Network access point. Location for interconnection of  internet service 
providers in the United States for the exchange of  packets.

Network - The infrastructure that supports electronic data exchange.

Network Adapter - A hardware device that translates electronic signals between a 
computing device’s native network hardware and the transmission media. A network 
adapter may also include memory or additional hardware or firmware to aid or 
perform the computing device’s network operations.

Network Address - Network layer address referring to a logical, rather than a 
physical, network device. Also called a protocol address.

Network Interface - Boundary between a carrier network and a privately-owned 
installation

Node - A networked computing device that takes a protocol address and can initiate 
and respond to communication from other networked devices that employ similar 
protocols.

Protocol - In networking, a specification of  the data structures and algorithms 
necessary to accomplish a particular network function.

Server - A device that is shared by several users of  a network.
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Stub Network - Network that has only a single connection to a router.

Token - Frame that contains control information. Possession of  the token allows a 
network device to transmit data onto the network.

Topology - The arrangement of  computing devices in a network.

User Interface - The collection of  display symbols and other sensory stimuli made 
by a computer that present information to a human and the collection of  physical 
action that a human can take to present data to a computer.
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Unit 2 Spreadsheets

Learning Outcomes
Learn how to use Microsoft Excel individually and in small groups by 
entering data into rows and columns to develop their understanding that a 
spreadsheet is a program with which data is processed.

They should have opportunities to investigate simple problems through 
calculations, graphs, and statistical analysis by using actual statistical data 
(e.g. students’ heights versus weights). 

For example, they might uses statistical data from the last population 
census to understand how to store, organize, and manipulate different data 
categories (state, gender, education, age, etc.), create charts, sort and filter 
data.

Use functions and formulas in data manipulation by organising and 
producing e.g. a pay sheet. 

They should learn how to import and export data. 

Key inquiry questions
• How is an Excel worksheet/workbook set up and managed? 

• How is data processed in MS Excel?

• How can business accounts be recorded?

• How is data summarized to produce reports?

• How are files and data protected in spreadsheets?

• How can examination results or other data be recorded in a tabulated 
manner?

• How can spreadsheets be used to evaluate an investment?

• How can an inventory be managed?
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2.0 Introduction to spreadsheets

A spreadsheets can also be defined as an application package designed to store, 
organize and manipulate numerical data and charts. Spreadsheet is also called 
electronic ledger. Examples of  spreadsheet include MS Excel, Lotus 1-2-3.

Every spreadsheet consists of  a large grid of  cells to store data which can then be 
manipulated using formulae. Each cell has an address which consists of  the column 
letter and row number. Many spreadsheet documents contain several individual 
sheets that can reference values in other sheets in the file. Spreadsheets can also 
produce graphs and other data visualizations.

2.0.1 Uses of Spreadsheets

1.   Accounting-Spreadsheet are used when preparing budgets and also when 
calculating profits.

2.   Statistical analysis-Spreadsheet also comes in handy when calculating 
statistical values e.g. mean, median and mode.

3.   Data management-They can also be used when organizing data in tabular 
manner. Spreadsheet is also used when doing operations such as sorting, 
filtering.

4.   Tracking value of  assets -Spreadsheet are also used when calculating 
appreciation and depreciation of  various assets and properties.

5.   Forecasting-Its automatic recalculation feature enables ‘what-if  ’ analysis..

2.1 Setting up and managing excel worksheet.

Once a new worksheet is opened it comprises of  a large number of  cells which have 
a standard width and height. The following changes may be necessary:

• You may add, remove or rename worksheets.

• You may change the height of  the rows.

• You may change the width of  the columns.

• An extra rows or column may also be added.

• Remove one or more rows or columns. 

Renaming a worksheet
In order to rename a worksheet the following steps apply:
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1.   Right click on the worksheet tab which you want to rename

2.   Select rename from the Pop Up menu

3.   Type new name for the Worksheet.

Activity 2.1

Create a new worksheet and rename it from sheet 1 to your name and save it into a
folder on your desktop.

2.1.1 Navigating in a Worksheet

It involves moving from one cell in a worksheet to another.

Figure 2.1 A worksheet

From the above screenshot, the home cell is cell A1.You can use the mouse pointer 
to navigate from one cell to another, thereby making the destination cell the active 
cell.
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2.1.2 Inserting and removing rows and columns.

In Excel columns are named using letters for example A, B, C… while rows are 
named using numbers example 1, 2, 3….

In order to add or remove a row or a column, the following steps are followed:

1.   Right-click on the row or column header.

2.   Choose the appropriate action from the menu.

   

Figure 2.2

In case you want to delete more than one row or column, select the number you 
want to insert and remove then follow the procedure above.

2.1.3 Adjusting rows height and column width

To change the row height or column width you may right click on the row or 
column you want to adjust or you may drag to adjust height/width:

Activity 2.2
On the worksheet that you renamed in the previous activity, follow the procedure 
above to insert a new row and column. Then adjust the height and width of  the 
row and column you have added, finally remove the row and column that you had
added. Save your work.
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2.1.4 Saving a Workbook

1.   From the Office Button, select Save As.

2.   Select the file type i.e. Excel Workbook
3.   Select the location or even folder where you would like to save the 

workbook.

4.   Name the file. E.g. Use your last name as the file name.

5.   Click Save.

2.2 Importing data in MS Excel
2.2.1 Importing data

Some text files contain lines of  characters, including both numbers and letters. To 
divide these lines of  text into columns of  data, characters such as commas or tabs 
are inserted to separate each field or column of  data. Text data can also be in a fixed 
width format, where the fields are aligned in columns with spaces between each 
field. Excel’s Text Import Wizard can import both of  these text file data formats. 
The Text Import Wizard takes the lines of  characters and converts them into data 
contained within the columns and rows of  an Excel file.

To import data: chose Data, Get External Data, and Import Text File from the 
menu bar. The import text dialog box appears. Choose the text file that you would 
like to import from Excel and double click on it or single click the file name, then 
click the Import button. Follow the instructions given by the Text Import Wizard 
dialog boxes that follow.

2.2.2 Exporting data

To export data from Excel to a text file, use the  Save As command. 
There are two commonly used text file formats:

Delimited text files (.txt), in which the TAB character (ASCII character
code 009) usually separates each field of text.

Comma separated values text files (.csv), in which the comma character
(,) usually separates each field of text.

You can change the separator character that is used in both delimited and .csv 
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text files. This may be necessary to make sure that the import or export operation 
works the way that you want it to.
You can convert an Excel worksheet to a text file by using the Save As command.

1.   Click the Microsoft Office Button  , and then click Save As. The
Save As dialog box appears.

2.   In the Save as type box, choose the text file format for the worksheet.

NOTE The different formats support different feature sets.

3.   In the Save in list, browse to the location where you want to save 
the new text file.

4.   In the File name box, review the name that Excel proposes for 
the new text file, and change it if necessary.

5.   Click Save.

6.   A dialog box appears, reminding you that only the current worksheet 
will be saved to the new file. If you are certain that the current 
worksheet is the one that you want to save as a text file, click OK 
. You may save other worksheets as separate text files by repeating 
this procedure for each worksheet.

7.   A second dialog box appears, reminding you that your worksheet 
may contain features that are not supported by text file formats. If 
you are only interested in saving the worksheet data into the new text 
file, click Yes

Activity 2.3
Open Microsoft Excel and import and export data to and from Microsoft Access. 
What conclusions can you draw on importing and exporting data?
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2.3 Cell References
The best way to construct a formula or a function is to use cell references i.e., use 
the cell addresses instead of  typing actual numbers. In turn, this enables Excel to 
automatically update the results of  the formulas and functions when you change 
the values in the cells referenced.

Using cell references in formulas and functions is also important when you copy 
a formula or function. When you copy the formula or function, the cell addresses 
will be copied in a particular way depending on how the cells are referenced. Ms 
Excel records cell addresses in formulas and functions in three different ways, these 
include:

2.3.1 Relative

The row and column references can change when you copy the formula to another
cell. It is usually the default cell reference mode.

Example 6.

See the formula in cell D2 below. Cell D2 references (points to) cell B2 and cell C2. 
Both references are relative.

Figure 2.17

Select cell D2, click on the lower right corner of  cell D2 and drag it down to cell 
D5.
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Figure 2.18

Cell D3 references cell B3 and cell C3. Cell D4 references cell B4 and cell C4. Cell

D5 references cell B5 and cell C5. In other words: each cell references its two
neighbors on the left.

2.3.2 Absolute

The row and column references do not change when you copy the formula. It 
is useful when there is a constant in a formula. Both the column letter and row
number are preceded by the dollar ($) sign.

Example 7.

To create an absolute reference to cell H3, place a $ symbol in front of  the 
column letter and row number of  cell H3 ($H$3) in the formula of  cell E3.

Figure 2.18

Now we can quickly drag this formula to the other cells.
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The reference to cell H3 is fixed i.e. when we drag the formula down and across. As 
a result, the correct lengths and widths in inches are calculated.

2.3.3 Mixed

In mixed reference either the row or column reference is relative, or the other 
is absolute.

Example 8.

See the formula in cell F2 below.

Figure 2.20

We want to copy this formula to the other cells quickly. Drag cell F2 across one 
cell, and look at the formula in cell G2.
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Figure 2.21

Observe what happens. The reference to the price should be a fixed reference to 
column B. Solution: place a $ symbol in front of  the column letter of  cell B2 ($B2) 
in the formula of  cell F2.

In a similar way, when we drag cell F2 down, the reference to the reduction should 
be a fixed reference to row 6. Solution: place a $ symbol in front of  the row number 
of  cell B6 (B$6) in the formula of  cellF2. The result are as shown below:

Figure 2.22

We do not place a $ symbol in front of  the row number of  B2, this way we allow 
the reference to change from B2 (Jeans) to B3 (Shirts) when we drag the formula 
down.

In a similar way, we don’t place a $ symbol in front o f  the column letter of  B6, 
this way we allow the reference to change from B6 (Jan) to C6 (Feb) and D6 (Mar) 
when we drag the formula across. Now we can quickly drag this formula to the 
other cells.
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Figure 2.23

The references to column B and row 6 are fixed.

2.4 Entering Data in MS Excel.

Introduction

There are three types of  data in cells: labels, values, and formulas.

• Labels (text) are descriptive pieces of  information, such as names, months, 
or other identifying statistics, and they usually include alphabetic characters.

• Values (numbers) are generally raw numbers or dates.

• Formulas are instructions for Excel to perform calculations.

To enter data into your worksheet you must first have a cell or range selected. 
When you open an Excel worksheet, cell A1 is already active. An active cell will 
appear to have a darker border around it than other cells on the worksheet. When 
constructing or editing a spreadsheet you will need to be able to navigate between 
cells and enter content.

Important points to note

• Click the navigation arrow or keys to move to a specific cell in the work 
sheet.

• Typing in a cell overwrites any existing content if  it is not blank.

• To edit a cell that already contains data, double-click or select it and edit the 
content in the formula bar.

• Once data has been entered or edited, you should press Enter or Tab. This 
makes the spreadsheet to:
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• Checks if  your data makes sense and reports any errors.

• Decide how numerical values should be formatted.

• Update all calculated values.

• Clicking the Escape (Esc) key at any point during data entry will end the 
process.

• Clicking Delete (Del) key will clear the contents, leaving the format 
unchanged.

Pressing Enter after data entry moves to the next cell down. Pressing Tab will move 
to the right. Holding Shift when pressing either Enter or Tab will move the cursor
in the opposite direction.

In MS excel a cell may contain either of  the following:

• Text data- may be anything that is not a number or formula.

• Numerical data- this may include dates, percentages, currency and time.

• Formula-are user defined mathematical expression.

2.4.1 Entering numbers with fractions.

To enter a fractional value into a cell, leave a space between the whole number and 
the fraction. For example, to enter 67⁄8: enter 6, press spacebar then 7/8 and then 
press Enter.

If  you have a fraction only e.g. 1⁄8: you must enter a zero first, like this: 01/8

Excel will likely assume that you are entering a date, excel automatically simplifies 
the fractions e.g. 4/8 = 1/2

Exercise 1

In groups follow the procedure to enter numbers with fractions.

1.   Start a new workbook.

2.   Create the worksheet as the one below.

3.   Save it as Fractions in your folder
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Figure 2.3

2.4.2 Entering Numbers as Text
Start by entering an apostrophe before the number (‘) e.g. ‘001, ‘002

Exercise 2

1.   Start a new workbook session.

2.   Create the worksheet below.
3.   Save it as text in your folder.

Figure 2.4
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2.4.3 Entering Date and Time Data

Dates are stored as whole numbers, the number increase by 1 every day. Time data 
is stored as decimal values where ‘0.5’ is midday. Both are then displayed using 
special formatting. This means a time and date can be stored as one decimal value

Excel automatically recognizes valid date and time data type. Valid date formats 
may include: 11/6/05, 6-Nov-05, 6-Nov, Nov 05 .Valid time formats may include:
21:41, 21:41:35, 9:41 AM, and 9:41:35 PM. There should be a space before

AM/PM.

To enter date and time values, the following procedure should be followed:

1.   Start a new workbook session.

2.   Create the worksheet below.
3.   Save it as date in your folder.

Figure 2.5

Using AutoFill to enter a series of values

It is a feature that inserts a series of  values or text items in a range of  cells.

Figure 2.6

                                              Auto-Fill Handle
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Steps involved:

1.   Enter the initial value e.g. 1
2.   Place the mouse pointer over the auto fill handle. It changes symbol from a 

white-plus-sign to a cross-hair

3.   Drag the AutoFill handle using the right mouse button. Excel displays a

shortcut menu with additional fill options.
4.   Select Fill Series option from the shortcut menu.

Exercise 3

In groups follow the procedure below on how to use the Auto-Fill Feature.

1.   Start a new workbook session
2.   Create the worksheet below by entering the initial value in each column and 

filling the rest of  the values using auto-Fill Feature
3.   Save it as auto-fill in your folder.

Figure 2.7
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2.4.4 Formatting Numbers

Values that are entered into cells are normally in general format so that they become 
easier to read for more consistency.

1. General

The General format is Excel’s standard number format. Every cell starts out with 
the same number format. If  a number has any decimal places, Excel displays them, 
provided they fit in the column. If  the number’s has more decimal places than 
Excel can display, it rounds up the last displayed digit, when appropriate. Excel also 
removes leading and trailing zeros. Thus, 004.00 becomes 4.

2. Number

The Number format is a General format with three modifications:

1.   It uses a fixed number of  decimal places which you can set

2.   It allows you to use commas to separate between groups of  three digits.
3.   It is also able to show negative numbers displayed with the negative sign, 

in parentheses.

3. Currency

The Currency format displays the currency symbol before the number. Always 
includes commas. It also supports a fixed number of  decimal places and allows you 
to customize how negative numbers are displayed.

Currency can be entered in two different ways:

1.   Enter the sum, including the currency symbol, eg: £1.50. This will be 
recognized as currency and formatted appropriately

2.   Enter the value only and then select the currency format.

Spreadsheets do not automatically convert currency values using number formatting 
for instance £1.50 + €1.50 will give a result of  3.00.
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Entering currency symbols:

1.   Enter the numeric value in the cell or select the range of  values
2.   Choose Format > Number > More Formats > More Currencies… and 

select the currency you require.

Figure 2.8

4.  Accounting

The Accounting format is showed on the Currency format. It allows one to choose 
a currency symbol, use commas and has a fixed number of  decimal places. The 
currency symbol’s always at the far left of  the cell and there’s always an extra space 
that pads the right side of  the cell. The Accounting format always shows negative 
numbers in parentheses, which is an accounting standard. The number 0 is never 
shown when using the Accounting format. Instead, a dash (-) is displayed in its 
place.
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5. Percentage

The Percentage format displays fractional numbers as percentages. For instance, 
if  you enter 0.5, that translates to 50%. You can choose the number of  decimal 
places to display.

6. Fraction

The Fraction format displays your number as a fraction instead of  a number with 
decimal places. The Fraction format doesn’t mean you have to enter the number 
as a fraction.

7. Scientific

It displays the first non-zero digit of  a number, followed by a fixed number of  
digits, and then indicates what power of  10 that number needs to be multiplied by 
to generate the original number. For example, 0.0003 becomes 3.00 x 10 -4 which 
is displayed in Excel as 3.00E-04.A number like 300, becomes 3.00 x 102 which is 
showed in Excel as 3.00E02.

8. Text

The Text format displays a number as though it were text, though you can still do 
calculations with it. Excel positions it against the left edge of  the column.

Steps for Formatting a Number

1.   Select the cell or range of  cells.

2.   Right-click the selection.

3.   Choose Format Cells option from the context menu.

4.   Choose a category.

5.   Choose a format similar to the one you desire
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Activity 2.4

In groups follow the steps given below to format numbers:

1.   Create the work sheet below.

2.   Format it to appear as shown below

3.   Save it as Format.

If  a cell displays a series of  hash marks(such as #########), it usually means 
that the column is not wide enough to display the value in the number format that 
you selected. Either make the column wider or change the number format.

2.5 Formula and function.

The distinguishing feature of  a spreadsheet program such as Excel is that it allows 
you to create mathematical formulas and execute functions. In Excel, the calculation 
can be specified using either a formula or a function. Formulas are self-defined 
instructions for performing calculations, In contrast, functions are pre-defined 
formulas that come with Excel.

2.5.1 Formula

A formula is a mathematical expression that returns a value. A formula is written 
using operators that combine different values, returning a single value that is then 
displayed in the cell. The most commonly used operators are arithmetic operators.
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Excel Arithmetic Operators: The Excel Operators perform actions on numeric 
values, text or cell references. The table below shows some of  them and the results 
they give.

Figure 2.9

Operator Precedence: It’s important to understand that when you create a formula 
with several operators, Excel evaluates and performs the calculation in a specific 
order. For instance, Exce l always performs multiplication before addition. This 
order is called the order of  operator precedence. The table below shows Ms excel
operator precedence.

Figure 2.10

Excel reads a formula containing these operators from left to right and performs 
the calculations following strict rules of  precedence:

1.   Parenthetical calculations first.
2.   Division or multiplication next in the order in which the calculations appear 

from left to right.

3.   Addition or subtraction next in the order in which the calculations appear

from left to right. For instance, consider the following formula:

=5 + 2 * 2 ^ 3 - 1
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To arrive at the answer of  20, Excel first performs the exponentiation i.e. 2 to the 
power of  3).

=5 + 2 * 8 - 1

and then the multiplication:

=5 + 16 - 1

and then the addition and subtraction:

=20

To control this order, you can add parentheses as shown.

• 5 + (2 * (2 ^ 3)) - 1 = 20

• 5 + 2 * 2 ^ (3 - 1) = 13

• (5 + 2) * 2 ^ 3 - 1 = 55

• (5 + 2) * 2 ^ (3 - 1) = 28

2.5.2 Entering Formulas

After the equal sign, a formula includes the addresses of  the cells whose values will 
be manipulated with appropriate operands placed in between. The operands are the 
standard arithmetic operators: Example

+ Addition =A7+A9

- Subtraction =A7-A9

* Multiplication =A7*A9

/ Division =A7/A9

ˆ Exponents =A7ˆA9
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You can also enter formulas by using the point mode, where you either click on a 
cell with your left mouse button or you use the arrow keys. For example to enter

’=B2+B3+B4+B5’ into cell B6 using the point method:

• Left click on cell B6 to make it active.

• Type ’=’.

• Use the up arrow key to move to cell B5, or left click on cell B5.

• Type ’+’.

• Use the up arrow or mouse to add cells B4, B3, and B2 in the same fashion.

• Press Enter when you are finished entering the formula.

You will notice that the calculation executes immediately after the formula is typed 
into the cell and entered by pressing either the Enter or Tab key or by clicking the 
check mark in the formula bar. The result of  the calculation is displayed in the cell
i.e. in B6.While the formula itself  is now visible in the formula bar.

Exercise 4

1.   Start a new workbook

2.   Create the work sheet below

3.   Enter formula cell E3 as shown

4.   Press enter to view the answer

5.   Copy the formula to fill the Purchase Amount for the other items

6.   Save it as STOCK
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Figure 2.11

7.   Set the Selling Price in a way that a profit of  25% is realized. In Cell F3 
enter the formula: =C3*1.25.

8.   Copy the formula to down to cell F6

9.   Find the Sell amount for each Item. In Cell H3 enter the formula: =F3*G3.

10. Copy the formula down to H6

11. Find the Stock level for each Item (Qty Purchased – Qty Sold)

12. Copy the formula down to H6.

13. Find the summation for all the values.
14. Find the average for all the values. Forma t the values appropriately e.g. 

quantity must be a whole number while monetary values should be to 2 
decimal places.

15. Resave the workbook.

16. The worksheet you have created should look like the one below.

Figure 2.12
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2.5.3 Common Formula Errors

#VALUE!

This occurs when the wrong data type has been used.
E.g.one may have used a function or created a simple 
arithmetic formula with a cell that contains text instead of  
numbers.

#NAME?

Occurs when Excel cannot find the name of  the
function that has been used. This error code usually 
means that a function name has been misspelled.

NUM!

It appears when a calculation produces a number that is too 
large or too small for Excel to deal with.

#DIV/0

You tried to divide by zero. This error code also appears if  
you try to divide by a cell that’s blank, because Excel treats a 
blank cell as though it contains the number 0 for the purpose 
of  simple calculations with the arithmetic operators.

#REF!

It shows that your cell reference is invalid. This error
often occurs if  you delete or paste over the cells you 
were using.

#N/A

Shows that the value isn’t available. This error can occur
if  you try to perform certain types of  lookup or 
statistical functions that work with cell ranges.

#NULL! Shows that the intersection operator has been used
incorrectly. The intersection operator finds cells what two 
ranges share in common. This error results if  there
are no cells in common

######## Excel has successfully calculated your formula.
However, the formula cannot be displayed in the cell 
using the current number format. To solve this
problem, you can widen the column, or change the 
number format.
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2.5.4 Functions

These are inbuilt MS Excel mathematical operations that returns a value given a 
range of  values. A function can be identified by its name e.g. SUM (), PRODUCT 
().

Functions differ from regular formulas in that, after the equal sign, you supply the 
cell addresses but not the arithmetic operators. Functions perform calculations by 
using specific values, called arguments, in a particular order called syntax. When 
using a function, remember the following:

• Use an equal sign to begin the function.

• Specify the function name.

• Enclose all of  the function’s arguments within parentheses.

• Use a comma to separate the function’s individual arguments

2.5.5 Function Categories

Functions are grouped into wide classes by some common features amongst them. 
These categories include:

1.   Financial - They are used to evaluate investments including appreciation or 
increase in value, depreciation or decrease in value, compound interest among 
many others.

2.   Date & Time - These functions are used when manipulating date and time 
values.

3.   Math & Trig - These may comprise of  general mathematics and trigonometric 
functions.

4.   Statistical - Are helpful when performing computations or calculations on list 
of  values.

5.   Lookup & reference - A lookup formula basically returns a value from a table 
by looking up another related value.

6.   Database - It performs statistical calculations and queries on databases.
7.   Logical -They are able to make a decision based on the outcome of  a given 

expression.

8.   Information - Gives information about a cell e.g. the formatting features applied 
to the cell.

9.   Engineering - These includes common engineering calculations
10. Text - Helps in manipulation of  text information.
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2.5.6 General Mathematical functions

1.   SUM()

2.   PRODUCT()

3.   EXP()

4.   POWER()

5.   ROUND()

6.   SQRT()

1. SUM ( )

They add up a group of  cells. They should be in the format: =SUM (range).
Range can be stated in 2 ways:

a)   =SUM (A1, A2) – This function adds two cells.ie cell A1 and cell A2. 
b)  =SUM (A2:A12) –This adds the range of  11 cells from A2 to A12.

2. PRODUCT ()

This function takes a list of  numbers, multiplies them together, and gives the result. 
For example:

a)   =PRODUCT (A1, A2, A3). 
b)  =PRODUCT (A1:A10).

Rounding Numbers: ROUND ( )

It rounds a numeric value to a specified number of  significan t figures e.g. decimal 
places. They should be in the format: ROUND (value, d.p.).For instance:

=ROUND (3.987, 2).The result is 3.99.

If  you specify 0 for the number of  d.p. Then Excel rounds to the nearest whole 
number.

ROUNDDOWN ( )

It rounds numbers towards zero. The result of  ROUNDDOWN (1.9, 0) is 
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1, ROUNDUP ( )

It rounds numbers up, away from zero. The result of  ROUNDUP (1.1, 0) is 2

3. POWER ()

It works out exponents. For instance =POWER (2, 3) => 8.It takes two arguments 
i.e. the base and the index.

4. SQRT ()

It finds the square root of  a number. For example=SQRT (9) =->3.It takes a single 
argument.

Statistical Functions

COUNT(), MAX(), MIN(), LARGE(), SMALL(), RANK(), AVERAGE(), 
MEDIAN(), MODE()

1.   Counting Values.
a)   COUNT (). Returns the number of  cells that contain a numeric value or date 

value. Format: = COUNT (Range).For example: =COUNT (A1:A10).This 
function ignores blank cells and cells with text data.

b)  COUNTA (). Returns the number of  cells with any data type. It is used to 
determine the number of  nonblank cells. It is usually in the format: = COUNT 
(Range).An example: =COUNTA (A1:A10).This function ignores blank cells.

c)   COUNTBLANK (). It returns the number of  blank cells. It is usually in the

format: = COUNT (Range) An example: =COUNTBLANK 
(A1:A10).

2.   Maximum and Minimum Values.

The MAX( ). It picks the largest value out of  a series of  cells. It is in the format:

=Max (range). An example: =Max (A1:A10).

MIN( ). Returns smallest value out of  a series of  cells. Usually in the format: format:

=Min (range).An example: =Min (A1:A10)
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The MAX ( ) and MIN ( ) functions ignore any non-numeric content, which includes 
text, empty cells, and Boolean (true or false) values. Excel includes dates in MAX ( 
) and MIN ( ) calculations because it stores them internally as the number of  days 
that have passed since a particular date.

3.   Ranking Your Numbers

LARGE( ). It returns the k-th largest value in a list e.g. the 5 th largest value in a list. 
An example: =Large (A1:A10, 5)

SMALL(). Returns the k-th smallest value in a list e.g. the 5 th smallest value in a list. 
An example: =SMALL (A1:A10, 5).It takes two arguments i.e. range and position 
in the list.

RANK( ). This function finds where a specific value falls in the list. It’s in the 
format, format: =RANK (number, range, [order type]).An example:

=RANK (A1, A1:A10) – ascending order, =RANK (A1, A1:A10, 1) – descending 
order

4.   Measuring Central Tendency.

AVERAGE( ). It finds the mean of  a list of  values. Usually in the format, format:
=AVERAGE (A1:A10).It takes one argument i.e. the range of  values. This function 
ignores all empty cells or text values.

MEDIAN( ). Finds the median of  a list of  values. If  the list is ordered in ascending 
order, the median is the value that lies in the middle position. Its format is, Format:
=MEDIAN (A2:A12)

MODE( ). Returns the value that appears the highest number of  times in a list of  
values. Usually in the format, format: =MODE (A1:A10).It ignores text values and
empty cells.
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Exercise 5

1.   Create the spreadsheet as the one below

2.   Use functions to fill the gaps.
3.   Save it as Exam.

Figure 2.13

2.5.7 Text Functions

CONCATENATE ( ) function

The CONCATENATE ( ) function lets you join together text in exactly the same 
way an operator does.

LEN ( ) Function

LEN ( ) usually short for Length. It counts the number of  characters in a string 
of  text. For example, the result of  the following formula is 5:= LEN (“Hello”).

Lako
Achok
Deng
Achiro
Oluak
Keji
Kana
Tumalo
Abdi
Dilek
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DATE/TIME Functions 

. TODAY ( ) Function.
This function displays the current date in a cell: It is in the format, 
format=TODAY ()

DAY () Function

The function takes a date argument and returns a number representing the day i.e. 
1 to 31.

MONTH ()

This function takes a date argument and returns a number representing the month 
i.e. 1 to 12.

YEAR ()

This function takes a date argument and returns a number representing the year
1900 to 9999. Example, if  you place the date 1/1/2007 in cell A1, the following 
formula displays a result of  2007:=YEAR (A1).

The NETWORKDAYS ( ) Function

The NETWORKDAYS ( ) function calculates the number of  work days between 
two dates, excluding weekend days i.e. Saturdays and Sundays. As an option, 
one can specify a range of  cells that contain the dates of  hoildays, which are 
also excluded. It is usually in the format: =NETWORKDAYS (Start Date, End 
Date,[Holiday Range])

An example: =NETWORKDAYS ( A15, 16, B2:B11)
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Figure 2.14

WORKDAY ( ) function.

The WORKDAY ( ) function gives an offset work day. An example: function to 
determine the date that is ten working days from January 4, 2008: =WORKDAY 
(1/4/2008, 10)

The WEEKDAY () function.

The WEEKDAY () function accepts a date argument and returns an integer 
between 1 and 7 that corresponds to the day of  the week. Sunday -1, Monday-
2…Saturday-7

=WEEKDAY ( 11/1/2011)

2.5.8 Manipulating Dates and Times

To enter a date in Excel, use the “/” or “-” characters. To enter a time, 
use the “:” (colon). You can also enter a date and a time in one cell.
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Figure 2.15

Date and Time values can be involved in calculations like addition, subtraction, and 
so on. For example, consider this formula : =A2-A1+1.If  A2 contains the value
10/30/2007, and A1 contains the value 3/20/2007, the result is 224, which is the 
number of  days between these two dates.

2.5.9 Lookup Functions

1. HLOOKUP ()
It is the horizontal lookup function. It works by scanning the values in a single row 
from left to right. Once it finds the entry you’re looking for, it can then retrieve 
other information from the same column. Has the Format: =HLOOKUP (Search 
Value, Table Range, row Number, [range Lookup])

2. VLOOKUP ()
It is the vertical lookup function. It works by scanning the values in a single column 
from top to bottom. Once it finds the entry you’re looking for, it can then retrieve 
other information from the same row. Usually in the format: VLOOKUP (search
for value, table range, column number)
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Figure 2.16

5.5.10 Financial Functions

These are functions that perform many of  the common financial calculations, such 
as the calculation of  yield, interest rates, duration, valuation and depreciation. 
Financial functions play a great role in evaluating an investment.

Financial Concepts

Present Value (PV). - The value of  an investment or loan at the very beginning 
of  its life. This number is also called the principal.

Rate - The rate at which an investment or loan will increase or decrease.

Future Value (FV) - The value of  an investment or loan at some point in the 

future. Payment -An amount of  money that is being contributed to an investment 

or loan.

Number of  Payment Periods (NPER)-The total number of  payment 
periods between the present value and the future value of  an investment 
or loan.
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FV ( ): Future Value Function

The FV ( ) function lets one calculate the future value of  an investment, assuming a 
fixed interest rate. It lets one factor in regular payments, which makes it perfect for 
calculating how money’s accumulating in a retirement or savings account.

It is usually in the format: =FV (rate, nper, payment, [PV], [type]) i.e.

Rate -the interest rate your investment’s earning.

Nper -the number of  interest payments. If  your account receives interest once 
a year and you invest your money over a two-year period, then the nper will be 
2.If  you’re making regular contributions, this value also specifies the number of  
contributions you’re making. FV ( ) assumes that every contribution’s made on 
the same day as the interest’s generated.

Payment -the amount of  the contribution you want to make regularly. Set this to 
0 if  you don’t want to add anything.

PV -the present value, or the initial balance of  your account. If  you omit this 
value, then Excel assumes you start with nothing. As a result, you’ll need to include 
something other than 0 for the payment.

Type - indicates the timing of  the payment. If  you specify 0 (or omit this value), 
then the payment is made at the end of  the period.

Make sure both the payment and the initial balance (PV) are negative numbers or 
zero values. In Excel’s thinking, the initial balance and the regular contributions are 
money you’re handing over, so these numbers, consequently, need to be negative.
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Loan Repayment
FV ( ) works just as well on loan payments. Example -you take out a $10,000 
loan and decide to repay $200 monthly. Interest is set at 7 percent and calculated 
monthly. FV () can tell you your outstanding balance that is, the amount that you 
still owe, after three years as follows: =FV (7%/12, 3*12, -200, 10000)

PV ( ): Present Value Function
It calculates the initial value of  an investment or a loan. This is also called the 
present value. It is usually in the format: =PV (rate, nper, payment, [fv], [type]).

The real purpose of  PV ( ) is to answer hypothetical questions. Consider this 
formula:=PV(10%/12, 25*12, 0, 1000000)

The question Excel answers here is: In order to end up with $1,000,000, how much
money do I need to invest initially, assuming a 10 percent annual interest rate 
(compounded monthly) and a maturation period of  25 years? The PV ( ) function 
returns a modest result of  $82,939.75.

You can supplement your principal with a regular investment. The following formula 
assumes a monthly payment of  $200, paid at the beginning of  each month. Note 
that you should type in a negative number, because it is money you’re giving up: 
=PV (10%/12, 25*12, -200, 1000000)

PMT ( ) Function
It calculates the amount of  the regular payments you need to make, either to pay 
off  a loan or to achieve a desired investment target.

You specify the present value and future value of  the investment and the rate of  
interest over its lifetime, and the function returns the payment you need to make 
in each time period.

Here is how the function breaks down: Usually in the Format: =PMT (rate, 
nper, PV, [fv], [type]).If  you don’t specify a future value, then Excel assumes it’s 
0, which is correct if  you are performing the calculation to see how long it will 
take to pay off  a loan.

Once again, the type argument indicates whether you make payments at 
the beginning of  the payment period (1) or at the end (0).
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Example: - If  you have a 7 percent interest rate compounded monthly and a 
starting balance of  $10,000, how much do you need to pay monthly to top it up to
$1,000,000 in 30 years? The PMT ( ) function provides your answer: 
=PMT (7%/12, 12*30, -10000, 1000000).

The result $753.16 is a negative number because this is money that you’re giving 
up each month.

A loan calculation is just as easy, although, in this case, the present value becomes 
positive, since it represents money you received when you took out the loan.

To determine the payments needed to pay back a $10,000 loan (that comes with a
10 percent annual interest rate) over five years, you need this formula: 
=PMT (10%/12, 12*5, 10000, 0)

Assuming you make payments at the end of  each month, the monthly payment is
$212.47. If  you add a type argument of  1 to pay at the beginning of  the month, 
then this amount decreases to $210.71.

NPER ( ): Number of  payment Periods Function

The NPER( ) function calculates the amount of  time it will take you to pay off  a 
loan or meet an investment target, provided you already know the initial

balance, the interest rate, and the amount you’re prepared to contribute for each 
payment.

They are usually in the Format: =NPER (rate, pmt, PV, [fv], [type]).Example: If  
you’re ready to contribute $150 a month into a savings account that pays 3.5 percent 
interest, you can use the following formula to determine how long it will take to 
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afford a new $4500 plasma television.

Assuming you start off  with an initial balance of  $500:=NPER(3.5%/12, -150, 
-500,

4500).The answer is 25.48 payment periods. Remember, a payment period in this 
example is one month, so you need to save for over two years. A similar calculation 
can tell you how long it’ll take to pay off  a line of  credit.

Assuming the line of  credit’s $10,000 at 6 percent, and you pay $500 monthly, here’s 
the formula you would use: =NPER (6%/12, -500, 10000, 0) In this case, It’ll take

21 months before you repay the debt.

2.6 Inventories in MS excel

Inventory is the goods or materials, work-in-process products and finished goods 
that are considered to be the portion of  a business’s assets that are ready or will be 
ready for sale. Inventories are also defined as assets owned by a firm business or 
company that are sold at a higher price than the one incurred when acquiring them.

Managing inventory through Excel makes it easy to organize inventory while saving 
monetary and time values. MS Excel is more preferable for small and medium sized 
businesses where inventory counts to fewer items. In small businesses, Excel is an 
excellent option to manage inventory and keep records of  sales and purchases, 
ordering and delivering and data keeping.

Excel offers various different inventory formulas to help in maintaining daily or 
routine business activities. To get the maximum out of  it, the user should first 
know

Click on cell B1 or press the “Tab” key on keyboard to move next cell on the right 
i.e. B1. Type “Receiving”, “In Date”, “Inventory In” or your preferred term to track 
when an item has been received.
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Figure 2.26

Enter header entries in our case we will enter, Shipped, Initials, Out Date and 
Comments in the cells C1, D1, E1 and F1 respectively. This will make the headers 
of  inventory complete. That helps have the basic heads under which the inventory
will be created.

Figure 2.27
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Place the cursor on columns on the line between columns A and B and click twice. 
This helps adjust the column width of  column A to adjust the content of  the cell. 
Repeat the same for all the columns. For the Comments column, place the cursor 
on the line between columns F and G, click and hold to increase column to your 
desirable width.

Figure 2.28

The next step is to do some formatting in order for the inventory to look 
professional. This may include adding a title. To do this place the cursor on row 1 
and click to highlight the complete row. Right click on “1” and select “insert”. This 
will insert a blank row above the Headers. Type the name of  inventory here.

Figure 2.29

Highlight the title, increase the font size, in our case we have increased to18. Place 
the cursor on cell A1 and drag it across to F1. Then click Merge & Center button 
in the Alignment group on Home tab. You can also give a shade to the title through 
fill color option in the Font group.
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Figure 2.30

The header should be more prominent than the listed items. For this highlight all 
the header columns. Increase the font size, Click on “B” to give boldface to the 
headers. Next you can give the header and distinguished color and also further 
highlight them by add color to header cells through Fill Color option. All these 
formatting options are available in the Font group in Home tab.In case the cells and 
columns overlap, adjust by adjusting the width of  columns.

You may add border to the inventory to give it a cleaner look. To do this highlight 
all the cells, select ‘All Bo rders’ from drop-down border list. Then select the 
Inventory List and select ‘Thick Box Border’ from the same list. This makes the 
inventory look more professional and neat.

Figure 2.31
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In our case select row 3. Go to “View” tab and then click “Freeze Panes.” Select

“Freeze Panes” from the drop-down menu. This helps you see the header no

matter how many inventories you will add or how far you go down the spreadsheet.

Figure 2.32

The inventory should be kept up to date by adding or amending records 
regularly and paying attention to accuracy.

Now the inventory worksheet is ready to be worked. Before start working on it, 
it is recommended to save the file.

MS Excel also has its own preset templates for inventory management. The user
can pick an inventory template from his choice from this list as well. These are 
pre - made templates with complete formatting and formulae inserted.

Activity 2.5
It would help to investigate preset templates and think about how each might 
be useful.



81

2.7 Charts

A chart is a visual or graphical representation of  numeric values. Charts helps 
us to quickly understand the data by plotting the data in graphs. MS Excel 
allows us to present data visually using charts.

Types of  Charts

Chart
Type

Use

1. Column Compares categories of  data in vertical format.

2. Bar Compares multiple values in horizontal format.

3. Line Displays trends in data over time.

4. Pie Compares data as part of  a contribution to a whole.

5. Scatter Plot Compares pairs of  values in a dot format.

6. Area Compares the trend of  values over time or categories.

7. Doughnut Compares multiple series of  data in a percent format.

8. Radar Displays changes in values relative to a center point.

9. Surface Displays trends in values across two dimensions.

10 . Bubble Compares sets of  three values.

11 . Stock Displays a chart to compare stock prices.

12 . Cylinder Same as a column or bar chart, but a cylinder is used 
instead.

13 . Cone Same as a column or bar chart, but a cone is used 
instead.

14 . Pyramid Same as a column or bar chart, but a pyramid is used 
instead.



82

2.7.1 Creating a chart

For most charts, such as column and bar charts, you can plot the data that you 
arrange in rows or columns on a worksheet into a chart.

1. On the worksheet, arrange the data that you want to plot in a chart. The data can 
be arranged in rows or columns. MS Excel automatically determines the best way 
to plot the data in

2. Select any cell within the data range that you want to use for the chart. If  
you select only one cell, Excel automatically plots all cells that contain data that 
is adjacent to that cell. If  the cells that you want to plot in a chart are not in 
a continuous range, you can select non-adjacent cells or ranges with Ctrl+Left-
Click, as long as the selection forms a rectangle. You can also hide any rows or 
columns you don’t want to plot in the chart.

To cancel a selection of  cells, click any cell on the worksheet.

3. On the Insert tab, in the Charts group, do one of  the following:

• Click the chart type, and then click a chart subtype that you want to use.

• To see all available chart types, click to launch the Insert Chart dialog 
box, and then click the arrows to scroll through the chart types.

   

Figure 2.33

A ScreenTip displays the chart type name when you rest the mouse pointer over 
any chart type or chart subtype.

4. By default, the chart is placed on the worksheet as an embedded chart. If  you 
want to place the chart in a separate chart sheet, you can change its location by 
doing the following:

Click anywhere in the embedded chart to activate it.This displays the Chart Tools, 
adding the Design, Layout, and Format tabs.
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On the Design tab, in the Location group, click Move Chart.

Under Choose where you want the chart to be placed, do one of  the following: 

To display the chart in a chart sheet, click new sheet.

To display the chart as an embedded chart in a worksheet, click Object in, and then 
click a worksheet in the Object in box.

5. Excel automatically assigns a name to the chart, such as Chart1 if  it is the first 
chart that you create on a worksheet. To change the name of  the chart, do the 
following:

a. Click the chart.
b.   On the Layout tab, in the Properties group, click the Chart Name text box. 
c. Type a new name.

d.   Press ENTER.

Activity 2.6

In pairs create a bar graph using in MS excel of  your form one examination results. 
Once complete share your design with another pair so that you can compare and 
contrast your design with others. Prepare to demonstrate to the class what other
ways you would design a bar graph in MS excel.

2.7.2 Adding chart elements

Chart elements are the different parts that make up a chart. Chart items except the 
chart area once selected can be moved around and resized relative to other items.
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Figure 2.34

Show or Hide a Chart Legend
When we have data for more than one item, we need to distinguish between 
the data. Chart legends are therefore used to show the differences between two 
categories. We can either show or hide a chart legend following the steps below.

1.   Click the chart you want to format.

2.   Click the Layout tab.

3.   Click Legend.

4.   Click a legend display option.

Add Titles
Chart title is the main title of  the chart, which represents the chat and tell users 
what the chart is all about. To add chart titles:

1.   1 Click the chart you want to format.

2.   2 Click the Layout tab.

3.   3 Click Chart Title.

4.   4 Click the title display option you want.

5.   5 Click the title, and then type the new title for the chart.
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Add and Remove Data Labels
Data labels includes values categories, names, series names, legend keys and values 
from cells. One may choose all of  them or a few as per his or her requirement. To 
add or remove data labels, one has to:

1.   1 Click the chart you want to format.

2.   2 Click the Layout tab.

3.   3 Click Data Labels.

4.   4 Click a data label option.

Show or Hide Chart Gridlines
Gridlines helps to quickly understand the values or percentages of  the data without 
looking for the exact values. By looking at the data series with grind lines, one is 
able to understand the approximate value of  the data. To show or add grind lines:

1.   1 Click the chart you want to format.

2.   2 Click the Layout tab.

3.   3 Click Gridlines.

4.   4 Click the set of  gridlines you want to change.

5.   5 Click a gridline display option.

Activity 2.7
In the bar graph you created in the previous activity (7), add and hide a title, legend 
and gridlines. Save your work.

2.8 Statistical analysis using excel
Excel can perform several statistical tests and analyses. For Excel to perform these 
tasks, you should make sure you have Data Analysis Tool pack installed. The Data 
Analysis is normally on the far right side of  the bar. If  you donot see it go to file, 
option, add ins and add the Analysis Tool.

2.8.1 Using Excel for Correlation

To do correlation, choose Tools Data Analysis → Correlation. In the Correlation 
popup, you will have to specify:

The range containing the observed values; if  the range includes the cells containing 
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the labels and if  you check the box next to Labels in the popup, your results will 
include those labels.

Whether the grouping is by columns or rows; if, as recommended, you have entered 
the values of  each variable into a column, you need to select the radio button for 
columns.

The upper left-hand corner of  the range in which you want the output to appear or 
you can choose a different sheet in the workbook, or a different workbook.

Excel displays the results in a 2x2 table (for the 2-variable case), showing the 
correlation of  each variable with itself  and with the other variable.

2.8.2 Using Excel for Linear Regression

In doing regression Excel insists that the observations be placed in columns rather 
than rows, i.e.it insists that the independent and dependent variables have their 
respective observed values entered in columns.

To do regression, choose Tools → Data Analysis → Regression. In the Regression 
popup, you will have to specify:

The range containing the observed values of  the dependent also called “Input 
Y” variable and of  the independent called “Input X” variable.

The confidence level if  you want to choose a level other than 95% which Excel 
provides you by default.

Whether you want to force the regression line to pass through the origin i.e., the 
point whose X and Y coordinates are both zero. If  you do want to force the 
regression to pass through the origin, check the box next to “Constant is Zero”; 
otherwise leave this box unchecked.

The upper left-hand corner of  the range in which you want the output to appear or 
you can choose a different sheet in the workbook, or a different workbook.

Finally whether you want the output to include displays of  other related data.

Activity 2.8

Collect data of  the height of  learners versus weight in your class and use Microsoft 
Excel to statistically analyze the data using linear regression. What are the major 
conclusions you come up with in the above analysis, and what information would 
you use to support the view.
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2.9 Sorting and filtering data.
2.9.1 Sorting data

As one adds more content to a worksheet, organizing this information becomes 
key. The quickest way to reorganize a worksheet is by sorting data. Sorting allows 
one to organize data based on some criteria, usually alphabetically i.e. A-Z or Z-A 
or numerically i.e. lowest to highest or highest to lowest.

Sorting in alphabetical order:

• Select a cell in the column you want to sort. In this example, let us choose a 
cell in column A.

• Click the Sort & Filter command in the Editing group on the Home tab.

• Select Sort A to Z. Now the information in the Category column is 
organized in alphabetical order.

Figure 2.35

You may also Sort in reverse alphabetical order by choosing Sort Z to A in the list. 

To sort from smallest to largest:
• Select a cell in the column you want to sort (a column with numbers).

• Click the Sort & Filter command in the Editing group on the Home tab.

• Select From Smallest to Largest. Now the information is organized from 
the smallest to largest amount.

You can sort in reverse numerical order by choosing From Largest to Smallest 
in the list.
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To sort multiple levels:

• Click the Sort & Filter command in the Editing group on the Home tab.

• Select Custom Sort from the list to open the dialog box.

Alternatively you can:

• Select the Data tab.

• Locate the Sort and Filter group.

• Click the Sort command to open the Custom Sort dialog box. From 
here, you can sort by one item or multiple items.

Figure 2.36

• Click the drop-down arrow in the Column Sort by field, then choose one 
of  the options in this example, Category.

Figure 2.37

• Choose what to sort on. In this example, we will leave the default as Value .
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• Choose how to order the results. In our case we leave it as A to Z so that 
it is organized alphabetically.

Figure 2.38

Click Add Level to add another item to sort by.

• Select an option in the Column Then by field. In this example, we chose

Unit Cost.

• Choose what to sort on. In this example, we will leave the default as Value .
• Choose how to order the results.  In our case we leave it as smallest to 

largest.
• Click OK.

Figure 2.39
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The spreadsheet has been sorted. All of  the categories are organized in alphabetical 
order, and within each category the unit cost is arranged from smallest to largest. 
It is good to note that no data and information has been lost, it has only been 
arranged in a different order.

2.9.2 Filtering data

Filter is an important tool in Ms Excel that allows to filter and retrieve only the 
required data from a large pool of  information. When data is filtered, only rows that 
meet the filter criteria will display, and other rows will be hidden. With data filtered, 
one can copy, format and print the data, without having to sort or move it first. To 
use a filter,

• Go to the Home Ribbon, click the arrow below the Sort & Filtering icon in 
the Editing Group and choose Filter.

Figure 2.40

Alternatively

• Go to the Data Ribbon, and then click Filter in the Sort & Filter Group.

You will notice that all of  your column headings now have an arrow next to the 
heading name. Click on the arrow next to the heading by which you want to filter, 
and you will see a list of  all the unique values in that column. Check the box next 
to the criteria you wish to match and click OK. Click on the arrow next to another 
heading to further filter the data.
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To clear the filter, choose one of  these options:

• Click on Filter icon next to the heading and choose Clear Filter from

“Name of  Heading”.

• Go to the Data Ribbon and click the Clear icon in the Sort & Filter Group.

• Go to the Home Ribbon, click the arrow below the Sort & Filtering icon in 
the Editing Group and choose Clear.

2.10 What if  analysis
One of  the most appealing aspects of  Excel is its ability to create dynamic models.
A dynamic model uses formulas that instantly recalculate when you change values in 
cells that are used by the formulas. When you change values in cells in a systematic 
manner and observe the effects on specific formula cells, you are performing a type 
of  what-if  analysis.

Types of  What-If  Analyses

• Manual what-if  analysis: Plug in new values and observe the effects on 
formula cells.

• Data tables: Create a special type of  table that displays the results of  
selected formula cell as you systematically change one or two input cells.

• Scenario Manager: Create named scenarios and generate reports that use
outlines or pivot tables.

2.10.1 Manual what-if analysis

Manual what-if  analysis is based on the idea that you have one or more input 
cells that affect one or more key formula cells. You change the value in the input 
cells and see what happens to the formula cells.
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Example:

Figure 2.41

With this worksheet, you can easily answer the following what-if  questions:

1.   What if  I can negotiate a lower purchase price on the property?

2.   What if  the lender requires a 20-percent down payment?

3.   What if  I can get a 40-year mortgage?

4.   What if  the interest rate increases to 7.0 percent?

You can answer these questions by simply changing the values in the cells in range
C4:C7 and observing the effects in the dependent cells (C10:C13).

FORMULA

C10 =C4*(1-C5)

C11 =PMT (C7/12, 
C6,- C4)

C12 =C11*C6

C13 =C12-C10
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2.10.2 Data Tables

A data table is a dynamic range that summarizes formula cells for varying input 
cells. You can create a data table easily, but data tables have some limitations. In 
particular, a data table can deal with only one or two input cells at a time.

Creating a one-input data table

Figure 2.42

A one-input data table displays the results of  one or more formulas for various 
values of  a single input cell. The Figure below shows the general layout for a one-
input data table.

You can place the data table anywhere in a worksheet. The left column contains 
various values for the single input cell.

The top row contains references to formulas located elsewhere in the worksheet. 
You can use a single formula reference or any number of  formula references. The 
upper-left cell of  the table remains empty. Excel calculates the values that result 
from each value of  the input cell and places them under each formula reference. 
For example:

This example uses the mortgage loan worksheet done earlier. The goal of  this 
exercise is to create a data table that shows the values of  the four formula cells (loan 
amount, monthly payment, total payments, and total interest) for various interest 
rates ranging from 6 to 8 percent, in 0.25-percent increments.
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Solution

The Figure below shows the setup for the data table area. Row 3 consists of  
references to the formulas in the worksheet. For example, cell F3 contains the 
formula =C10, and cell G3 contains the formula =C11.Column E contains the 
values of  the single input cell (interest rate) that Excel will use in the table.

Figure 2.43

• To create the table, select the data table range (in this case, E3:I12) and then 
choose:
Data ➪ Data Tools ➪What-If  Analysis ➪ Data Table.

Excel displays the Data Table dialog box, as the one shown in Figure below.

• You must specify the worksheet cell that contains the input value. Because 
variables for the input cell appear in the left column in the data table, you 
place this cell reference in the Column Input Cell field. Enter C7 or point 
to the cell in the worksheet. Leave the Row Input Cell field blank. Click OK, 
and Excel fills in the table with the calculated results.
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Figure 2.44

 Using this table, you can now see the calculated loan values for varying 
interest rates. If you examine the contents of the cells that Excel entered as a 
result of this command, you’ll see that the data is generated with a multi-cell 
array formula:{=TABLE(,C7)}

Figure 2.45
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2.10.3 Scenario Manager

Data tables are useful, but they have a few restrictions. These include:

1.   You can vary only one or two input cells at a time.

2.   Setting up a data table is not very intuitive.
3.   A two-input table shows the results of  only one formula cell although you 

can create additional tables for more formulas.

In many situations, you may be interested in a few select combinations, not 
an entire table that shows all possible combinations of  two input cells. The 
Scenario Manager Feature makes automating your what-if  models easy. You can 
store different sets of  input values usually called changing cells for any number 
of  variables and give a name to each set.

You can then select a set of  values by name, and Excel displays the worksheet by 
using those values. You can also generate a summary report that shows the effect 
of  various combinations of  values on any number of  result cells. These summary 
reports can be an outline or a pivot table.

For example, your annual sales forecast may depend upon several factors. 
Consequently, you can define three scenarios: best case, worst case, and most likely 
case. You then can switch to any of  these scenarios by selecting the named scenario 
from a list. Excel substitutes the appropriate input values in your worksheet and 
recalculates the formulas.

Defining scenarios

The figure below is an example that uses a simplified production model.

Figure 2.46

B9:=(Hourlylaborcost*B7) + 
(Material cost*B8)

B11: =B10-B9
B13

=B11*B12
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This worksheet contains two input cells: the hourly labor cost (cell B2) and the unit 
cost for materials (cell B3). The company produces three products, and each
product requires a different number of  hours and a different amount of  materials 
to produce. Formulas calculate the total profit per product (row 13) and the total 
combined profit (cell B15).

A management is trying to predict the total profit, but uncertain what the hourly 
labor cost and material costs will be, they have identified three scenarios, listed 
in Table below

The Best Case scenario has the lowest hourly cost and lowest materials cost. The 
Worst Case scenario has high values for both the hourly cost and the materials cost. 
The third scenario, Most Likely Case, has intermediate values for both of  these
input cells. The managers need to be prepared for the worst case, however, and they 
are interested in what would happen under the Best-case scenario.

Solution

• Choose Data ➪ Data Tools ➪ What-If  Analysis ➪ Scenario Manger to 
display the Scenario Manager dialog box.

• When you first open this dialog box, it tells you that no scenarios are 
defined — which is normal because you are just starting.

• As you add named scenarios, they appear in the Scenarios list in this dialog 
box.
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Figure 2.47

To add a scenario, click the Add button in the Scenario Manager dialog box. Excel 
displays its Add Scenario dialog box, shown in Figure below

Figure 2.48
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This dialog box consists of  four parts, namely:
1.   Scenario Name: You can give the scenario any name that you like, 

preferably something meaningful.
2.   Changing Cells: The input cells for the scenario. You can enter the cell 

addresses directly or point to them. If  you have created a name for the cells, 
type the name. The number of  changing cells for a scenario is limited to 32.

3.   Comment: By default, Excel displays the name of  the person who created 
the scenario and the date when it was created. You can change this text, add 
new text to it, or delete it.

4.   Protection: The two Protection options (preventing changes and hiding 
a scenario) are in effect only when you protect the worksheet and choose 
the Scenario option in the Protect Sheet dialog box. Protecting a scenario 
prevents anyone from modifying it; a hidden scenario doesn’t appear in the 
Scenario Manager dialog box.

In this example, define the three scenarios that are listed in Table above. The 
changing cells are Hourly Cost (B2) and Materials Cost (B3).After you enter the 
information in the Add Scenario dialog box, click OK. Excel then displays the 
Scenario Values dialog box. This dialog box displays one field for each changing cell 

that you specified in the previous dialog box. Enter the values for each cell in the 
scenario.

Figure 2.49

If  you click OK, you return to the Scenario Manager dialog box, which then displays 
your named scenario in its list. If  you have more scenarios to create, click
the Add button to return to the Add Scenario dialog box.
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Figure 2.50

Displaying scenarios
After you define all the scenarios and return to the Scenario Manager dialog box, 
the dialog box displays the names of  your defined scenarios. Select one of  the 
scenarios and then click the Show button. Excel inserts the corresponding values 
into the changing cells and calculates the worksheet to show the results for that 
scenario. Figure below shows an example of  selecting worst case scenario.

Figure 2.51

2.10.3 Reverse What-If Analysis

If  you know what a formula result should be, Excel can tell you the values that you 
need to enter in one or more input cells to produce that result. In other words, you 
can ask a question such as “How much do sales need to increase to produce a profit 
of$1.2 million?” Excel provides two tools that are relevant:
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1.   Goal Seek: Determines the value that you need to enter in a single input cell 
to produce a result that you want in a dependent formula cell.

2.   Solver: Determines the values that you need to enter in multiple input 
cells to produce a result that you want. Moreover, because you can specify 
certain constraints to the problem, you gain significant problem solving 
ability.

Goal Seek

In Single-cell goal seeking, Excel determines what value in an input cell produces 
a desired result in a formula cell. A goal-seeking example

Figure 2.52

The figure above shows the mortgage loan worksheet used in the previous 
sub- topic. This worksheet has four input cells (C4:C7) and four formula cells 
(C10:C13).This example demonstrates the opposite approach. Rather than supply 
different input cell values to look at the calculated formulas, this example lets Excel 
determine one of  the input values that will produce the desired result.
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Assume that you are in the market for a new home and you know that you can 
afford a $1,800 monthly mortgage payment. You also know that a lender can issue a

30-year fixed-rate mortgage loan for 6.50%, based on an 80% loan-to-value i.e., a
20% down payment. The question is “What is the maximum purchase price you 
can handle?” In other words, what value in cell C4 causes the formula in cell C11 
to result in $1,800?

In the above example, you could plug values into cellC4 until C11 displays $1,800. 
With more complex models, Excel can usually determine the answer much more 
efficiently. To answer the question posed, first set up the input cells to match what 
you already know. Specifically:

1.   Enter 20% in cell C5 (the down payment percent)

2.   Enter 360 in cell C6 (the loan term, in months)

3.   Enter 6.5% in cell C7 (the annual interest rate)

Next, choose Data ➪ Data Tools ➪ What-If  Analysis ➪ Goal Seek. Excel displays 
the Goal Seek dialog box, shown in Figure below.

Figure 2.53

Completing this dialog box is similar to forming a sentence. You want to set cell 
C11 to 1800 by changing cell C4. Enter this information in the dialog box eithe r 
by: Typing the cell references or by pointing with the mouse. Click OK to begin the
goal-seeking process. In less than a second, Excel displays the Goal Seek Status 
box, which shows the target value and the value that Excel calculated. In this case, 
Excel found an exact value. The worksheet now displays the found value in cell C4 
($355,974). As a result of  this value, the monthly payment amount is $1,800. At this 
point, you have two options:
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1.   Click OK to replace the original value with the found value.

2.   Click Cancel to restore your worksheet to the form that it had before you
chose Goal Seek.

Figure 2.54

2.10.4 Solver

The Excel Goal Seek feature is a useful tool, but it clearly has limitations. It can 
solve for only one adjustable cell, and it returns only a single solution.

Excel’s powerful Solver tool extends this concept by enabling you to do the 
following:

• Specify multiple adjustable cells.

• Specify constraints on the values that the adjustable cells can have.

• Generate a solution that maximizes or minimizes a particular worksheet 
cell.

• Generate multiple solutions to a problem.
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2.11 Workbook protection

Ms Excel includes a Protect Workbook command that prevents others from 
making changes to the layout of  the worksheets in a workbook. You can assign a 
password when you protect an Excel workbook so that only those who know the 
password can unprotect the workbook and change the structure or layout of  the
worksheets.

2.11.1 Setting a password for a workbook
1.   Click the Microsoft Office Button, and then click Save As.
2.   Click Tools, and then click General Options.
3.   Do one or both of  the following:

• If  you want reviewers to enter a password before they can view the 
workbook, type a password in the Password to open box.

• If  you want reviewers to enter a password before they can save changes to 
the workbook, type a password in the Password to modify box.

4.   If  you don’t want content reviewers to accidentally modify the file, select the 
Read-only recommended check box. When opening the file, reviewers will be 
asked whether or not they want to open the file as read-only.

5.   Click OK.
6.   When prompted, retype your passwords to confirm them, and then click OK.
7.   Click Save.
8.   If  prompted, click yes to replace the existing workbook.
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Exercise 6

1.   What are the main features of  MS Excel?
2.   What is a cell?
3.   Differentiate between a worksheet and a workbook?
4.   How many data formats are available in Excel? Name some
5.   Specify the order of  operations used for evaluating formulas  in Excel.
6.   Explain few useful functions in Excel.
7.   Explain workbook protection types in Excel.
8.   Explain how cell reference is useful in the calculation?

9.   Which function is used to determine the day of  the week for a date?
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Remember
SPREADSHEETS

Absolute Cell Reference: An absolute cell reference is one that does not change 
when it is copied. To make a cell reference absolute, you must include a $ before 
the reference (ex: $C$4).The other type of  reference is a Relative Reference.

Active Cell: The active cell is the cell in the spreadsheet that is currently selected
for data entry. You can change which cell is the active cell by clicking the left mouse 
button once or using the arrow keys on the keyboard. The current active cell can be 
identified as being the one that has a darker black border around it. Also, the active 
cell reference is listed in the Name Box directly above the spreadsheet’s column 
headings.

Anchor Cell: The anchor cell is the first cell that is highlighted in a range. When 
a range of  cells is selected, they appear as highlighted in black. The anchor cell, 
however, remains white. If  only one cell is selected in the sheet, it is the anchor cell.

Bar / Column Chart: A bar or column chart is a style of  chart that is used 
to summarize and compare categorical data. The length of  each bar represents 
the aggregate value (ex: sum) of  that particular category. Bars run horizontally 
and columns run vertically.

Cell: A cell is a rectangular area formed by the intersection of  a column and a row. 
Cells are identified by the Cell Name (or Reference, which is found by combining 
the Column Letter with the Row Number. For example the cell in Column “C” 
in Row “3” would be cell C3. Cells may contain Labels, Numbers, Formulas or 
Functions.

Cell Reference: A cell reference is the name of  the cell that is found by combining 
the Column Letter with the Row Number. For example the cell in Column “C” in 
Row “3” would be cell C3.

Column: Columns run vertically on the spreadsheet screen. An Excel spreadsheet 
contains 256 columns that are labeled with the letters of  the alphabet. When the 
column labels reach letter “Z” they continue on with AA, AB, AC...... AZ and then 
BA, BB, BC.....BZ etc.
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Column / Bar Chart: A column or bar chart is a style of  chart that is used to 
summarize and compare categorical data. The length of  each bar represents the 
aggregate value (ex: sum) of  that particular category. Columns run vertically 
and Bars run horizontally.

Data: Data refers to the type of  information that can be stored in the cells of  
a spreadsheet. Spreadsheet data types include values (numbers), labels, formulas 
and functions.

Enter key: The Enter Key on the keyboard is used to accept any data that has been 
typed in a cell and move the active cell down vertically to the next one in a column.

Fill: Fill is a feature that can be used to quickly copy data from the anchor cell to an 
adjoining range, updating the data if  appropriate. This means that if  the anchor cell 
contains a formula with relative cell references, those references will automatically 
update relative to their position when copied to a new location. Fill can also be 
used to automatically populate common lists of  data such as days of  the week or 
months. Fill can be used to copy data either horizontally or vertically in a range.

Fill Handle: The fill handle is the small bold square in the bottom right corner 
of  a cell that can be used to copy (fill) data to adjacent cells in the same row or 
column. When you hover over the fill handle box, the mouse pointer will change 
to a black plus sign. You may then click the left mouse button, (and hold it down) 
while selecting the adjacent cells to copy to. Releasing the mouse button will then 
fill the content.

Filter: Filtering will allow you to quickly find the information that you are looking 
for in a spreadsheet. When you apply a filter, you control the data that is displayed 
on the screen by setting criteria. Data contained in rows that don’t meet your 
criteria will temporarily disappear from view when the filter is applied. When the 
filter is cleared, all of  the data will once again appear in the spreadsheet.

Formula: A formula is a spreadsheet data type that will calculate a result and 
display it in the active cell. A formula is written using cell references and must begin 
with an equal sign “=” to distinguish it from a label. An example of  a formula 
would be: =A3+C3 which would take whatever value was entered into cell A3 and 
add it to the value that was typed into C3. After typing the formula and pressing 
the Enter key, the resulting value will be displayed.

Formula Bar: The formula bar appears directly above the column headings of  a 
spreadsheet and will display what has been typed into the active cell. For example, 
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if  you click on a cell that contains the formula =A3+C3, the cell itself  will show 
the result of  the formula. The formula bar, however, will display what has actually 
been typed into the cell which, in this case, is =A3+C3.

Freezing Columns and/or Rows: Freezing is a technique that can be used in larger 
spreadsheets to assist in viewing the information on the screen. If  a spreadsheet 
contains many rows, you can freeze the rows containing your heading labels so 
that as you scroll down in the sheet the headings stay at the top and line up with 
the appropriate data. Likewise, if  your spreadsheet contains many columns, the 
leftmost columns may be frozen so that they stay with the data as you scroll to the 
right.

Function: this are built-in formulas that are used to enter either commonly used 
or very complex formulas. Like formulas, functions begin with an equal sign “=” 
and use cell references in their format. One commonly used function is the Sum 
function, which will add up the values in a range. The function: =sum(H2:H25) 
would add all values contained in cells H2 through H25 and return the result when 
the enter key is pressed.

Gridlines: this are the horizontal and vertical lines on the screen that separate 
cells in a spreadsheet. Gridlines typically do not print unless the option is set in the 
layout options of  the spreadsheet.

Labels: Labels refer to text that is typed into the cells of  a spreadsheet. Labels 
have no numeric value and cannot be used in a formula or function.

Name Box: The name box appears to the left of  the formula bar and displays 
the name of  the current cell. Unless you define a cell or range of  cells with a 
specific name, the name box will display the cell reference of  the active cell.

Pie Chart: A pie chart is a circular chart that is divided up into sections, each 
of  which represents the numerical proportion of  the whole.

Print Area: The print area is used to specify a range of  cells that will be printed, 
rather than printing an entire worksheet. This is particularly useful for very 
large worksheets with multiple columns and rows.

Print Titles: Print titles are used to repeat column or row titles on each page. 
That way, if  a spreadsheet prints on multiple pages, each page will contain the 
appropriate headings to identify the data.

Range: A range is a group of  cells in a spreadsheet that have been selected. If  the 
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cells are all together in a rectangular or square shape, it is an adjacent range. An 
adjacent range is identified by the cell reference in the upper left and lower right 
corners of  the selection separated by a colon. (Example: A3:B5). In this example, 
the range would include all cells in the rectangular area formed by beginning the 
highlighting in cell A3 and dragging down to B5. You can consider the colon as 
the word “through”. In this case, the range would include cells A3 through B5.

Relative Reference: A relative cell reference is one that changes when it is copied. 
For example, if  a formula that contains the cell reference “C4” is copied to the 
next cell to the right, the reference will change to D4 (updating the column letter). 
If  the same formula is copied down one cell, the reference will change to “C5” 
(updating the row number). The other type of  reference is an Absolute Reference.

Rows: Rows run horizontally on the spreadsheet screen. An Excel spreadsheet 
contains 16,384 rows which are labeled numerically.

Sheet Tabs: In Microsoft Excel, the sheet tabs appear below the worksheet grid 
area and allow you to switch from one worksheet to another in a workbook.

Sort: Sorting is used to arrange information in a particular order. When sorting data, 
you may choose multiple levels of  criteria and sort in either ascending or descending 
order. For example, a spreadsheet of  data could be sorted first alphabetically in 
ascending order by last name and then by first name.

Tab Key: The tab key on the keyboard is used to accept any data that has been 
typed in a cell and move the active cell horizontally to the next one in a row.

Values: Values are numeric data that is entered into a cell. When data is formatted 
as the value type, it can be referred to in formulas and functions and used in 
calculations.

Workbook: A workbook is a collection of  worksheets that are saved together in 
one file. Individual worksheets can be given descriptive names and you can switch 
from one worksheet to another by using the sheet tabs that appear beneath the 
worksheet grid area.
Worksheet: A worksheet is the grid of  columns and rows that information is 
inputted into. In many spreadsheet applications (such as Microsoft Excel) one file 
called a workbook -- can contain several worksheets. Worksheets can be named 
using the sheet tabs of  the bottom of  the spreadsheet window. The sheet tabs can 
also be used to switch from one worksheet to another within a workbook.
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Unit 3 Social Media

Learning Outcomes
• They should learn about the importance of social media.

• They should develop individual expertise by creating personal 
accounts to join different social media. 

• They should be able to communicate by posting messages, 
requesting friends, adding friends, posting images, tweeting news, 
etc.

• Learners should discuss and understand the power of social media.

• They should understand social media and their roles

Key inquiry questions
• What are social media and how could they be classified and differentiated 

from traditional media?

• How do the virtual communities interact and exchange information?

• How could individuals and institutions benefit from social media?

• What impact has virtual social media on the traditional media 
institutions and on societies? 

• What are the ethical and legal issues and risks relating to social media?
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3.0 Introduction to social media
Social Media; This is media used in social interactions, using available and accessible 
publishing techniques. It uses web-based technologies to turn communication 
into interactive dialogues. According to Wikipedia, the free encyclopedia Social 
media are computer-mediated technologies that facilitate the creation and sharing 
of  information, ideas, career interests and other forms of  expression via virtual 
communities and networks.

Figure 3.1 Social media icons

3.0.1 Social media and traditional media

Traditional media is also called industrial media. It may include both print and 
electronic media. Social media is different from industrial or traditional media,
such as newspapers and television. It is fairly cheap and are accessible to enable 
anyone access information, compared to industrial media, which generally require 
a lot of  resources to publish or even access the information. One characteristic 
shared by both social media and industrial media is the capability to reach small 
or large audiences. For instance a message on say Twitter or an advertisement on 
television may attract a small or even millions of  people. There are several properties 
that help describe the differences between social media and industrial media. These 
properties may include:

1.   Accessibility - the means of  production for industrial media are mostly owned 
privately or by government; social media tools are generally available to anyone 
at little or no cost.

2.   Usability - industrial media production typically requires specialized skills and 
training. Most social media does not, or in some cases reinvent skills, so anyone 
can operate the means of  production.
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3.   Recency - the time interval between communications produced by industrial 
media can be long it can take days, weeks, or even months compared to social 
media which can be capable of  almost prompt replies, only the participants 
determine any delay in response.

4.   Permanence - industrial media, once created, cannot be altered i.e. once a
magazine article is printed and distributed, changes cannot be made to that 
same article while social media can be altered almost immediately by comments 
or editing.

3.0.2 Classification of social media

Social media can be classified into different categories. These may include:

1.   Social networking sites-It is a platform where people interact with 
each other. The most popular example of  this category is Facebook.

2.   Blogging: It is a platform where discussions revolves around one topic.

Normally the topic of  discussion is termed to be trending.
3.   Media Sharing: Media sharing is becoming inevitable nowadays. It involves 

sharing or the exchange of  videos, audios or even pictures.in video sharing 
some of  the sites used include YouTube and vimeo, in the sharing of  
audios platforms such as sound cloud come in handy while in sharing of  
pictures Flickr is a perfect example.

4.   Document Sharing: It is a platform that is used in sharing documents like
spreadsheet or even presentations with other users. Websites such as google 
drive and slide share are some examples.

5.   Social News: This is a platform which enables one to find all the news 
especially those related to social media. An example of  this platform is 
Digg.

3.0.3 Benefits of using social media

1. To institutions.

Social networking platforms may allow organizations to improve communication 
and productivity by distributing information among different groups of  employees 
in a more efficient manner, resulting in increased productivity. Among the benefits 
of  using social media by an institution include.

• Helps in open communication, leading to enhanced information delivery.

• Allows employees to discuss ideas, post news and ask questions.
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• Provides an opportunity to widen business contacts.

• Targets a wide audience, making it a useful and effective recruitment tool.

• Improves business reputation and client base with minimal use of  
advertising.

• Expands market research, implements marketing campaigns, delivers 
communications and directs interested people to specific web sites.

2. To individuals.

The way people communicate has been changed in comparison to the previous 
years largely due to social media. For individuals the benefits of  social media may 
include:

• Personal use: An individual may use social media for reasons such as 
keeping in touch with what is happening in the world, or get the latest 
news or even keep in touch with the developing technology. For instance 
it is common for people to use emails to keep in touch with friends. Social 
media also helps individuals to talk to people in real time, this has been 
made possible by use of  skype.

• Enhance creativity: Individuals may also use social media to explore 
their creativity for instance a writer may create their own blogs and hence 
enhance their writing skills. One may also upload photos using the photo 
sharing sites and by so doing explore their talents in photography.

• Social interactions: Social media also helps people to interact with each 
other using highly accessible communication techniques like mobile phones. 
Other social networks like Facebook aid a lot in social interactions.

3.1 Common social media sites
3.1.1 Facebook

Figure 3.2 Facebook icon

It is a social network service and website launched in February 2004 that is operated 
and privately owned by Facebook, Inc. Users may create a personal profile, add 
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other users as friends and exchange messages, including automatic notifications 
when they update their profile. Additionally, users may join common interest user 
groups, organized by workplace, school, or college, or other characteristics.

The name of  the service stems from the colloquial name for the book given 
to learners at the start of  the academic year by university administrations in 
the US with the intention of  helping learners to get to know each other better. 
Facebook allows anyone who declares themselves to be at least 13 years old to 
become a registered user of  the website.

Creating a Facebook account is normally free, and it takes only take a few 
minutes. Once you have created an account, you have the ability to share exiting 
things with friends, upload pictures, and chat with friends, among many other 
things.

Creating an account.

1. Open the Facebook homepage; you will need to be at least 13 years old 
to create a Facebook account. Facebook accounts are free. You can only create 
one Facebook account per email address.

Figure 3.3

2. Enter in your information; On the Facebook homepage, enter in your first 
name, last name, email address, password, birthday, and gender. You must use 
your real name for your account. Nicknames may be allowed as long as they are a 
variation on your real name for example Chris instead of  Chrispine.

3. Facebook will send an email to the email address you provided. This is to ensure 
that you have given a real email address and one that you genuinely have access to. 
Click on the button Confirm Your Account . A numeric confirmation code is also 
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provided and you may be asked to type this it.

Figure 3.4

Setting up your profile

1. Add a profile picture; you can use either a photograph that is on your computer 
or can be accessed from another device. Example a phone. Many people choose to 
put a picture of  something other than themselves for their profile, for instance a 
cartoon or favorite pet. If  you choose not to put a photo at this time your profile
will appear with a head and shoulders outline

Figure 3.5

2. Add friends; Facebook is nothing if  you don’t have friends and family to 
share with. You can search for people by their name or email, import your 
contact lists, and invite friends that aren’t currently using Facebook.

Facebook will suggest people it thinks you may know and give you a list with 
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profile photos so you can recognize them. If  you would like to connect with 
someone on this list click on the Add Friend button. This will send a Friend 
Request to them – it is their choice whether or not to accept your request.

Figure 3.6

3. Manage your privacy settings; there are countless shocking stories of  people 
posting things that they don’t want others to see, or losing a job because of  
something controversial they shared. Take some time to set up your privacy settings 
to prevent the wrong people from seeing what you post.

Using Facebook.

1. Share and post; you can post to your own timeline or post to your friends’ 
timelines. You can also share content from elsewhere on the internet, including 
links, images, and videos.

2. Chat on Facebook; Facebook allows you to chat with anyone on your friends 
list. If  the person you are chatting with is not online, they will receive your message 
the next time they log in. You can also download the Messenger app for your
phone to chat on the go.

3. Upload photos; Facebook allows you to upload your photos to post to your 
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profile and share with friends and family. You can upload single photos or organize 
your photos into albums. Make sure to not upload anything containing questionable 
content.

4. Create an event; you can use Facebook to create events and invite people. 
You can set the date and time, enter a location, make posts for people that will be 
attending, and invite specific people. Facebook events are quickly becoming one 
of  the main ways that people organize gatherings.

Activity 3.1

In groups discuss how Facebook can be used to promote peace in South Sudan. 
What information would you use to support your view?

3.1.2 Twitter

Figure 3.7 Twitter logo

It is a website, owned and operated by Twitter Inc. It offers a social networking and 
micro blogging service, enabling its users to send and read other users’ messages 
called tweets. . Tweets are text-based posts displayed on the user’s profile page. 
Tweets are publicly visible by default, however senders can restrict message delivery 
to their friends list. Users may subscribe to other users’ tweets. This is known as 
“following” and subscribers are known as “followers.”
All users can send and receive tweets via the Twitter website, compatible external 
applications such as for smartphones, or by Short Message Service (SMS) 
available in certain countries. While the service is free, accessing it through SMS 
may incur phone service provider fees. The website is based in San Francisco, 
California. Twitter also has servers and offices in San Antonio, Texas and Boston, 
Massachusetts.
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Creating an account

Different social media has different uses, strengths, and advantages. Twitter can be 
understood as a real time social networking site, that enables sharing of  information 
as it happens and for connecting with others in real time.

Figure 3.8

When creating an account, first and foremost go to Twitter’s homepage. You 
should see options to either log in or sign up in the upper right of  the screen. If  
you are on a tablet or smartphone, you could be redirected to the mobile website 
of  Twitter.

Click on Sign Up; this will start the process of  creating a new Twitter account. 
After clicking signup, you will be redirected to the first step of  the sign-up process.

Enter your full name; you may use your real name so that your friends can easily 
recognize your Twitter account.

Enter a valid e-mail address; any e-mails or news from Twitter will be sent to this 
e-mail address. This email is normally used for recovering the account if  you ever 
forget your log in information. You can also use your mobile phone number if  you 
want that option for account recovery.

Enter in a username; In addition to your real name, this will be shown on 
your profile and will be another way people can find you. If  you have ever seen 
a @ symbol, followed by a name, it is likely a Twitter username. Twitter will 
also automatically suggest some names for you based off  of  your real name. 
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The username isn’t too important, so any one of  these options would be fine.

Check or uncheck the “Tailor Twitter based on my recent website visits” 
option. If  checked, this option will allow Twitter to look through your browser 
history on websites with the Twitter widget and suggest people to follow based 
on your patterns. Many websites have this Twitter widget, so it could be helpful 
if  you want some suggestions on interesting accounts to follow. However, if  you 
would like more privacy online, do not check this box.

Enter a strong password; be sure that your password is not too easy to guess, 
but no so hard that you can’t remember it. Note down the password somewhere 
so you don’t forget it.

Enter your phone number; if  you used an e-mail account in one of  the previous 
steps, you will be prompted to enter a valid phone number. After registering your 
number, you will receive a text with a confirmation code. If  you do not receive 
this text, you likely entered in the wrong number. Enter in the code after clicking 
“Next.” Now, if  you forget your login credentials, Twitter can send them to this 
number.

Confirm your e-mail address; by this point, you should have received an e-mail 
from Twitter to the address you previously entered. Follow the instructions in the 
e - mail to confirm your address.

You can now use Twitter and all of  its features Search for and follow friends and 
your favorite celebrities and also organizations.

How to communicate in tweeter.

Communication and interactions in tweeter are through short messages of  280 
characters or less called tweets. You can post updates on Twitter, along with photos 
and videos, and you can interact with others by favoriting their post to indicate that 
you like it, retweeting a post so that it is broadcasted to your followers or private 
messaging.

Sending a Tweet on Twitter.

After signing up to twitter, there is a box at the top right containing a feather. Click 
on that and a box will appear. This is where you type your message. You also have 
the option here to add a photo or video, share your location, or add a poll.
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If  you would like to reference someone in your tweet, add their Twitter handle 
beginning with the “@” symbol. If  you want to establish a keyword that others 
can use to add to the conversation, add a hashtag (#).

Reply to a Tweet.

When you want to reply to a tweet, hit the arrow which is located under and to 
the far left of  the post that you want to reply to. Doing so will open a box in 
which you can enter your message. The handle(s) of  the person or people that you 
are replying to will already be posted in the message box, ensuring that it will be 
directed to them when you hit the “Tweet” button.

Retweet on Twitter.

At times you may read something funny or noteworthy that you would like to 
retweet. Twitter makes it easy by providing an icon just for this purpose. Tap or 
click the icon second from the left under the tweet. A box will appear with the 
original post and space for you to enter an additional comment. Click on “Retweet” 
and the post will appear on your profile page with your comment attached to it.

Activity 3.2

In groups, discuss how twitter may be used for positive reason such as promoting 
environmental sustainability in South Sudan.
Also research and discuss any possible negative impact of  Twitter.

Present your conclusions to the class.

3.1.3 YouTube

Figure 3.9 Youtube logo

It is a video-sharing website on which users can upload, share, and view videos. 
Three former PayPal employees created YouTube in February 2005.The company is 
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based in San Bruno, California, and uses Adobe Flash Video technology to display 
a wide variety of  user-generated video content, including movie clips, TV clips, and 
music videos, as well as amateur content such as video blogging and short original 
videos. Most of  the content on YouTube has been uploaded by individuals,

although media corporations including CBS, BBC, VEVO and other organizations
offer some of  their material via the site, as part of  the YouTube partnership 
program.

Unregistered users can watch the videos, while registered users are permitted to 
upload an unlimited number of  videos. Videos that are considered to contain 
potentially offensive content are available only to registered users 18 and older. In 
November 2006, YouTube, LLC was bought by Google Inc. and now operates as a
subsidiary of  Google.

Creating an account.
YouTube allows users to search and browse millions of  community and comment, 
rate and make video responses to their favorite videos, upload and share your 
videos with millions of  other users and save favorite videos to watch and share 
later. Steps for joining YouTube include:

Visit the YouTube Web site in order to get started. In creating a YouTube 
account, you are also creating a Gmail account. This will appear as [YouTube 
username]@gmail.com.

Click on the “Create an account” button under the login form on the login page.

If  you already have a Gmail account, you should have a YouTube account. Use
your Gmail username and password to log into YouTube.

Figure 3.10
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Fill out the requisite information. Fill out your e-mail address, user name, date of  
birth, gender and click “I Accept”.

Figure 3.11

Give a phone number for verification that you are not a machine. To cut down 
on fake accounts, Google sometimes will make you provide verification.

Click on the box “I agree to the Google Terms of  Service and Privacy Policy “Click 
the Create My Account button. If  you leave any fields empty or if  you choose a 
username that’s taken already, YouTube refreshes the page with red warning notes 
identifying the fields that need to be corrected before you can register.

Decorate your YouTube page; on your profile page, you can add a main picture 
and your own background, among other things. Try to express yourself.

Among the benefits one enjoys by creating a YouTube account include:

• Making and adding videos to the YouTube community.

• Tracking your favorite users by subscribing to their channel.

• Manage your favorite tracks, videos, and online episodes.
• Commenting on videos and socializing with other members of  

the YouTube community.
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Uploading a video to YouTube

Uploading videos to YouTube is a quick process from either your mobile device or 
from your computer. Through uploading videos you are able to share your videos 
with friends and family. The steps involved include:

Copy the video from your camera to your computer. Before you upload the 
video to YouTube, make any edits that you would like, and then make sure that it is 
converted into a proper format. Some of  the formats accepted by YouTubeinclude: 
Audio Video Interleaved (AVI), 3rd Generation Partnership Project (3GPP),
Motion Picture Experts Group Part 14 (MP4), Motion Picture Experts Group

(MPEG or .MPG) among many other formats.

Log in to your account. Each account has its own channel attached to it. Sign 
in to the account that is associated with the channel that you want to upload the 
video to.

Click the upload button and choose a video file. Click the “Select files to 
upload” button to open a file browser. Find the file or files that you want to add.

Click the open button then enter the details. Some of  the required information 
includes the title of  the video, the description of  the video, and any tags that you 
want to add. You may then share the video online.

Activity 3.3

In groups create a YouTube channel and upload an authentic video showing some 
physical features in South Sudan. Prepare to demonstrate the steps your group 
used to upload the video.

Base on your knowledge on YouTube what are your main recommendations to new
YouTube users?
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3.1.4 Instagram

Figure 3.12 Instagram logo

Instagram is a social media app that allows users to share photos and videos from 
their lives, add captions, edit filters, engage with others, explore among many other 
things. Users can connect their Instagram account to other social media profiles, 
enabling them to share photos to those profiles as well.

It was created by Kevin Systrom and Mike Krieger, and launched in October 
2010 as a free mobile app exclusively for the iOS operating system. A version for 
Android devices was released two years later, in April 2012, followed by a feature- 
limited website interface in November 2012, and apps for Windows 10 Mobile and 
Windows 10 in April 2016 and October 2016 respectively.

Creating an account

To join Instagram, you can create an account of  your own for free. You can do this 
on your preferred mobile platform or, set your account up on a computer.

1. Using mobile.

Tap your phone’s app store app to open the app store. You will need to 
download the Instagram app in order to create and access an account on your 
mobile platform. On iOS devices, this app is called “App Store”; while on Android 
phones and tablet it is known as the “Google Play Store”.
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Figure 3.13

Figure 3.14

Search for the “Instagram” app. On both iOS and Android platforms, you can 
do this by tapping the magnifying glass icon in the app store app and then typing 
in your search query.

Tap the relevant button to download Instagram. Since Instagram is a free app, 
you will see a button next to the app that says either “Get” (iOS) or “Install”
(Android).It may take a few minutes to download.
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Figure 3.15

Tap the Instagram app. This will open Instagram.

Figure 3.16

Tap the “Sign Up” button. This will allow you to enter your preferred account 
information.
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Figure 3.17

Enter your preferred email address in the field provided. Tap “Next” when 
you’re done. Make sure that this is a current email address to which you have access. 
You can also choose to log in with your Facebook credentials from here. If  you 
tap the “Log in with Facebook” option, Instagram will ask you to log into your 
Facebook page if  you aren’t already logged in.

Enter a username and password. You’ll need to enter the password twice in 
order to confirm its accuracy. Make sure you like your username before clicking 
“Next”.

Enter optional account details. These include a profile picture, or a bio for your 
account. You can add or change this information at any time from within your 
Instagram profile by tapping the “Edit Profile” option at the top of  your page.
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Figure 3.18

Tap “Done”. This will create your account.

2. Using computer

Open your preferred browser. While your Instagram browsing experience is 
limited in comparison to mobile when using a computer, you can still set up and 
access your account from Instagram’s site.

Navigate to Instagram’s website.

Enter your sign-up information on the right side of  the page. This information 
includes the following:

• A current email address.

• Your full name.

• Your preferred username.

• Your preferred password.

• You can also click “Log in with Facebook” at the top of  this information 
entry box to create an account with your Facebook name and password. 
This will link your Facebook and Instagram accounts.
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Click the “Sign Up” button. This is at the bottom of  the sign-up menu; doing 
so will create your account.

Click the person icon in the top right corner of  your screen. This will take 
you to your account page.

Click the “Edit Profile” option. This should be to the right of  your Instagram 
name at the top of  your page.

Add any information you wish to display. This may include a bio for your 
account or a profile picture. When you are done, click the “Submit” button at the 
bottom of  your page. With that tour Instagram account is created.

Activity 3.4

Create and customize your Instagram profile. Demonstrate how to set your account 
as “private”, thereby requiring that you approve any new follower requests and 
Connecting your account to other social networking sites, enabling them to share 
uploaded photos to those sites.

3.2 Ethical and legal issues in social media

Ethics can be understood as a set of  rules or standards governing the conduct of  
a person or the members of  a profession. While legal issues can be understood to 
mean enforceable by being in conformity with the law of  the land and the public 
policy meaning it is not condemned as illegal.

Although there are many benefits in the use of  social media, these benefits must 
be weighed against the potential shortcomings. These may include truthfulness 
and accuracy of  posted information, the source of  the posted information among 
many other issues. This means that when using social media as a communication 
tool there are many ethical and legal issues involved as well as risks.

The legal challenges faced when using social media involve user rights, whereas the 
ethical challenges concentrate on the responsible use of  social media. It may also 
involve how the privacy of  a user is maintained and protected as they use social 
media.
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3.2.1 Legal issues

Legal queries raised over social media use center around issues of  copyright and 
privacy. This is so because most countries do not have laws directly addressing 
issues of  social media.

Intellectual property rights are among the pertinent issues that researchers, 
archivists, librarians, and others confront when harvesting social media data. Digital 
platforms have become increasingly complex, and social media use has escalated, 
creating new avenues of  research data. Intellectual property can be understood as a 
means of  protecting creative works on behalf  of  theowners. These exclusive rights 
for original works include the rights to reproduce, distribute, display, or prepare 
derivative works. This means that if  one uses the original work of  person from 
the social media without the consent of  the owner, then one can be sued in a court 
of  law. This extends even to the use of  photographs gotten from social sites like 
tweeter.

Privacy on social media concerns the boundaries between legal and ethical 
considerations. An increase in computer technology means that it is easier to 
accumulate data and connect various data points about an individual, which is more 
difficult to do with written records.

Privacy can be understood as the right “to be let alone”. Violation of  one’s privacy 
may understood in different dimensions these may include:

• The invasion upon a person’s private affairs,

• Public revelation of  embarrassing private facts about a person.

• Publicity which places a person in a false light.

• Misappropriation or the use of  a person’s name and image for commercial 
advantage without their prior consent.

In conclusion, social networking users do not enjoy immunities granted to social 
networking sites under the law, so they should be careful to always act appropriately 
when posting messages or files to the social sites.

Activity 3.5
In groups discuss find out the legal issues in major social media sites (Facebook, 
YouTube, twitter, Instagram). In your own opinion what would like to be a priority 
in ensuring online safety on social media sites. What information would you use to 
support your view?
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3.2.2 Ethical issues

Despite of  its functional and useful potential in social and development growth 
in human’s communication, there are many ethical issues in social networking that 
should be taken into deep caution and consideration. Among them include:

Privacy
The internet contains wealth of  data and it is always a serious subject of  concern 
for privacy issues in social networking sites. The problems of  data privacy have 
been made worse by the growing number of  youth flocking into these online social 
networks without or paying little attention to privacy issues for themselves or

others. Although term and conditions were always made to be seen and agreed
during user’s registration process, most of  the time, users tend to ignore the 
policy and assume that everything would be in a good place without realizing 
that we might solely permit a gateway access of  breach to our precious personal 
information.

Freedom of speech
Freedom of  speech is a valid political pathway recognized as a human right. This 
means that everyone has the right to freedom of  opinion and expression. Although 
free speech is always seen as modest to many and supported in democratic ideology, 
it is a dangerous weapon for specific group of  people to manipulate the right to 
release or spark an unethical sentiment such as racial or religious hatred within the 
digital space through the social media.

Leakage of data
In social networking sites, data leakage problem can be traced back where it is 
most possibly to be caused by user’s minimal awareness and understanding on the 
ethical privacy and protection value on the policies used by each respective social 
networking sites. Frequent updates on social networking’s timeline such as current 
interest and location can be manipulated and compiled as a valuable data source 
of  information in data leakage. Even though each of  these social networking sites 
have been clearly mentioned their privacy policies, it is all up to the users to fully 
take control on what should be exposed and what should remain confidential.

Identity Theft
Identity theft is one from many examples of  ethical issues in social networking. It 
is a form of  technique used by criminals to impersonate someone’s identity with 
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intention to pursue or commit a crime. The victim will be held responsible for the 
consequences of  fraud or action done by the impersonators. Identity theft on the 
Internet can arise in two ways which are either creating a fake account or stealing 
and hacking the password of  the victim.

Activity 3.6

Kiden is a journalist working with a news agency in juba, What choice would you 
recommend her to make in order to make sure she respect people’s privacy while 
adhering to ethical issues in major social media sites while still exercising her right
to free speech?

Exercise 1

1.   What are the benefits of  social media in marketing firms?

2.   State five differences between traditional media and social media.
3.   Outline the major legal and ethical issues associated with the use of  social 

media.

4.   How would you justify the need for strict regulation on privacy and security

issues in social media sites?
5.   Based on what you know about social media, how could you promote social 

wellbeing through social sites in your local community?
6.   Taban is farmer, which social media sites would you recommend him to use 

to market, learn and share more knowledge about his produce? Justify your 
answer with the knowledge and experience you have gathered about social 
media.
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Remember
SOCIAL MEDIA

Blog - Blog is a word that was created from two words: “web log.” Blogs are 
usually maintained by an individual or a business with regular entries of  content 
on
a specific topic, descriptions of  events, or other resources such as graphics or 
video. “Blog” can also be used as a verb, meaning to maintain or add content to 
a blog.

Blogger - Blogger is a free blogging platform owned by Google that 
allows individuals and companies to host and publish a blog typically on a 
subdomain. Example: yourblogname.blogspot.com.

Bookmarking  - Bookmarking online follows the same idea of  placing a 
bookmark in a physical publication -- you’re simply marking something you 
found important, enjoyed, or want to continue reading later. The only differe 
nce online is that it’s happening through websites using one of  the various 
bookmarking services available, such as Pocket, or right within your browser.

Chat - Chat can refer to any kind of  communication  over the internet 
but traditionally refers to one-to-one communication  through a text-
based chat application, commonly referred to as instant messaging (IM) 
applications.

Comment - A comment is a response that is often provided as an answer 
or reaction to a blog post or message on a social network.

Direct Message - Direct messages -- also referred to as “DMs” -- are private 
conversations that occur on Twitter. Both parties must be following one another 
to send a message.

Ebook - An ebook is an electronic version of  a book. However, most ebooks 
are not actually available in print (unless you print them). These are typically 
published in PDF form. For marketers, ebooks commonly serve as lead 
generating content -- people must fill out a form to receive their ebook copy.
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Forums - Also known as a message board, a forum is an online discussion 
site. It originated as the modern equivalent of  a traditional bulletin board, and 
a technological evolution of  the dial-up bulletin board system.

GIF - GIF is an acronym for Graphics Interchange Format. In social media, 
GIFs serve as small-scale animations and film clips.
Handle - Handle is the term used to describe someone’s @username on Twitter.
Hashtag - A hashtag is a tag used on a variety of  social networks as a way to 
annotate a message. A hashtag is a word or phrase preceded by a “#” (i.e.
#InboundMarketing). Social networks use hashtags to categorize information 
and make it easily searchable for users.

Instant Messaging - Instant messaging (IM) is a form of  real-time, direct text- 
based communication between two or more people. More advanced instant 
messaging software clients also allow enhanced modes of  communication, such 
as live voice or video calling.

Live streaming - Live streaming is the act of  delivering content over the internet 
in real-time.

Meme - A meme on the internet is used to describe a thought, idea, joke, or 
concept that’s widely shared online. It is typically an image with text above and 
below it, but can also come in video and link form.

News Feed - A news feed is literally a feed full of  news. On Facebook, the News 
Feed is the homepage of  users’ accounts where they can see all the latest updates 
from their friends. The news feed on Twitter is called Timeline.

Search Engine Optimization - Search engine optimization is the process of  
improving the volume or quality of  unpaid traffic to a website from search engines.

Selfie - A selfie is a self-portrait that is typically taken using the reverse camera 
screen on a smartphone or by using a selfie stick (a pole that attaches to your 
camera). Selfies are commonly shared on social media networks like Instagram, 
Twitter, and Facebook using the hashtag #selfie.

Tag - Tagging is a social media functionality commonly used on Facebook and 
Instagram that allows users to create a link back to the profile of  the person shown 
in the picture or targeted by the update.
Trending Topic - Trending topics refer  to the most  talked about 
topics and hashtags on a social media network. These commonly 



135

appear on networks like Twitter and Facebook and serve  as clickable 
links  in which users  can either click through to join the conversation 
or simply browse the related content.

Troll  - A troll  or internet troll  refers to a person who  is known for 
creating controversy in an online setting. They  typically hang  out in 
forums, comment sections, and chat  rooms with  the intent of  disrupting 
the conversation on a piece of   content by providing commentary that 
aims  to evoke a reaction.

User-Generated Content - User-generated content is content -- 
blogs, videos, photos, quotes, etc.  -- that  is created by consumers. 
Marketers typically tap into their  audience in an online setting to 
collect this type  of   content to support a campaign or initiative.

Viral  - Viral  is a term  used  to describe an instance in which a piece  
of   content -- YouTube video, blog  article, photo, etc.  -- achieves 
noteworthy awareness. Viral distribution relies  heavily on word  of   
mouth and the frequent sharing of  one particular piece  of   content all 
over  the internet.

Vlogging - Vlogging or a vlog  is a piece  of   content that employs video  
to tell a story  or report on information. Vlogs are common on video  
sharing networks like YouTube.


